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1 Getting started

Introduction

Thank you for purchasing the HP 9100C Digital Sender. This color, 
network digital sender helps you quickly and conveniently distribute 
paper documents in electronic format. The digital sender works with 
other devices and programs so you can:

� E-mail — Send a document directly to Internet e-mail 
destinations.

� Fax — Fax a document to one or more destinations (if your 
company has a LAN fax program). 

� Make copies — Make high-quality copies by sending a document 
to a network printer.

� Send to your computer — Send a document to your computer 
where you can file documents, search for text, and add text notes. 
You can also send documents to e-mail, fax, print, and more.

� Send to another program — Send a document to a network folder 
so the document is available to a program on the network.

� Send to an HP JetSend-enabled device — The digital sender is 
an HP JetSend-enabled device that can send documents to other 
HP JetSend-enabled devices in your office.

The HP Address Book Manager (ABM) is a program on your 
computer that manages fax and e-mail destinations you use at the 
digital sender. The HP Digital Sender Link (Link) routes documents 
sent to your computer to the storage location.
EN Introduction 7



Coexistence with an HP Network ScanJet 5 
scanner

The HP 9100C Digital Sender and the HP Network ScanJet 5 
scanner coexist on the same network without conflict. Documents 
sent to your computer from the HP Network ScanJet 5 scanner are 
routed using the HP ScanJet Utility, and you can continue to use the 
PaperPort™ software for HP to manage the scanned documents. 
Documents sent to your computer from the HP 9100C Digital Sender 
are routed using the HP Digital Sender Link.

If you would like, you can use just use one program on your computer 
to manage scanned documents. Specify the target program as the 
Preferred Inbox for the HP Network ScanJet 5 scanner and set the file 
type to .pdf (if available) or multipage .tif. (See the documentation for 
the HP Network ScanJet 5 scanner to set these options.) Documents 
are still routed using the HP ScanJet Utility, but they appear in the 
target program.

System requirements

To install and use the four included programs and the online 
documentation, your computer needs the following:

� a Pentium® processor

� Microsoft® Windows 9x, or Windows NT 4.0 or 5.0 (Intel PC)

� For Windows 9x: 16 MB RAM minimum, 32 MB RAM 
recommended.
For Windows NT 4.0 or 5.0: 32 MB RAM minimum, 64 MB RAM 
recommended.

� a VGA monitor

� 41 MB of free hard disk space
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Installing the software

The software consists of four components:

� HP Digital Sender Link. This program is necessary if you want 
to send documents to your computer.

� HP Address Book Manager. The ABM program is the means for 
adding, changing, and deleting fax and e-mail destinations stored 
in the digital sender. It is also needed for viewing the activity log.

During the software installation, you can accept the default installation 
of all components and an electronic copy of the user guide. This is 
known as a typical installation. Or, you can choose to install only 
certain programs, which is known as a custom installation. Doing a 
typical installation is strongly recommended.  

You can install the software either from the network or from the 
installation compact disc. Before you begin, you need to know where 
the install program is located (if installing from the network) and 
where you want the programs and the data files to reside (if you do 
not accept the default). If you cannot find the install program, contact 
the administrator for this digital sender (hereafter referred to as the 
administrator).
EN Installing the software 9



To install on Windows 9x, NT 4.0, or NT 5.0

1 Turn your computer on and quit any open programs.

2 Do one of the following:

• If you get a message from the administrator saying there is 
new software available for this product, follow the instructions 
in the message for installing it.

• If the software is being installed from the network, log in to the 
network, click Start and then Run. Type the path the 
administrator gave you and click OK.

• If the software is being installed from the compact disc, the 
setup program begins as soon as you insert the compact disc. 
When prompted, make sure to choose to install the end-user 
software.

3 When the installation program begins, follow the instructions on 
the screen. During the installation, you need to specify the 
following:

• Which programs to install. By default, all programs are 
installed.

• Where to store the programs. You can accept the default 
location or choose another location on your computer.

• The path to the default inbox. The default inbox is the place 
where data sent to your computer is stored. You can accept 
the default location or choose another location on your 
computer or the network.

All the programs you selected will be installed. If an error occurs 
during installation, see “Installation troubleshooting” on page 11.

Note The target program receives and displays documents sent to your 
computer. To learn more about choosing a target program, see 
“Configuring the target program” on page 84.

After installation
After installing the software, you or the administrator needs to 
establish your registered user profile to allow you to use all the 
capabilities of the digital sender. See “Your user profile” on page 12.
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Installation troubleshooting
Use the following table to help resolve error messages and common 
problems encountered while installing software.

Uninstalling HP Digital Sender Link and HP 
Address Book Manager
To uninstall the HP Digital Sender Link and the HP Address Book 
Manager programs: Click Start, point to Programs, then HP 9100C, 
and click Uninstall HP 9100C. Follow the instructions on the screen 
to complete the uninstall.

Problem or message Description

The software did not install on 
Windows 9x.

All programs except Explorer and Systray should be closed before 
installing software. Press CTRL+ALT+DELETE. If there are other 
open programs, click one and click End Task. Repeat for each 
other open program. Then, reinstall the software.

The computer cannot read the 
installation compact disc.

The correct drive might not have been specified. Check for the 
proper drive letter. Often, it is D or E for the CD-ROM drive.
Check the compact disc for damage. Try using the compact disc 
on another computer, or copy the compact disc folders to the hard 
drive. Then, install from the hard drive.

“This machine has been configured by 
your network administrator as a digital 
sender server. The Link application 
cannot work if this service is running. 
To be able to receive scanned 
documents directly on this PC, the 
administrator must disable the digital 
sender server. Do you want to 
continue?”

The computer on which you are trying to install the software has 
the HP Digital Sender Service or the upgrade for the HP Network 
ScanJet 5 scanner installed already. Contact the administrator 
before proceeding.
EN Installing the software 11



Your user profile

There are two different types of users for the digital sender: 
registered users and guest users. Registered user must establish a 
user profile, and they have full access to all features. Guest users do 
not have to establish a user profile, but they also do not have full 
access to all features.

Registered users

As a registered user, you have the following privileges.

� You can use the digital sender even if the administrator disables 
guest usage. 

� You can send documents to your computer. Without a registered 
user profile, you cannot send to your computer.

� You can use the ABM program. In the ABM, you will have a 
Private Email address book and a Private Distribution Lists 
address book, where you can store often-used addresses and 
lists for use at the digital sender. (See “Introducing the HP 
Address Book Manager” on page 15.) 

� In the ABM, you have rights to add, change, and delete fax 
destinations in the Public Fax address book. 

� You see information in the activity log under your name. When 
using the digital sender as a guest user, you cannot tell your 
activity from the activity of any other guest user.

� You can have the digital sender send you e-mail notifications of 
the status of faxes or e-mail messages you send from the digital 
sender. (Your e-mail and LAN fax programs must support 
notification.)

To become a registered user, see “Adding a registered user profile” 
on page 13.
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Guest users

If you are a guest user, you cannot use the digital sender if the 
administrator disables guest usage. 

If guest usage is enabled, you can use the digital sender and choose 
destinations in the Public Email, Distribution Lists, and Fax address 
books. However, you do not have Private Email and Distribution Lists 
address books. You also cannot use the ABM to alter information in 
any address books or for any other purpose.

As a guest user, you cannot send documents to your computer. And, 
you cannot receive e-mail notification of the status of faxes or e-mail 
messages you send from the digital sender.

Adding a registered user profile
You or the administrator can set up your user profile. Your profile is set 
up and changed in the ABM.

To add a registered user profile

1 On the Windows taskbar, right-click  and choose HP Address 
Book Manager. The HP 9100C login screen opens.

2 In the Digital Sender name field, type the DNS name or IP 
address for the digital sender. If you do not know this information, 
ask the administrator.

3 In the User name field, type your name as it will appear at the 
digital sender’s control panel. For consistency, it is recommended 
that all users enter their names with the last name first.

4 If you want to protect access to your address books with a 
password, type one in the Password field.

Note If you do not set a password, other users might be able to log in at the 
digital sender using your name, access destinations in your private 
address books, and send e-mail messages using your name.
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5 Select the New User check box. The dialog box expands.

6 If you typed a password, retype it in the Confirm password field.

7 If you will want to receive confirmations of fax and/or e-mail 
transmissions, type your e-mail address in the User e-mail 
address field.

8 The ABM automatically detects the address of your computer and 
inserts it into the User PC address field. You can modify this 
field, but it is not recommended.

9 Click Create.

Note You might receive a message saying you have been created as a user 
and are logged in to the ABM, but that the administrator must enable 
your account. If you receive this message, you can work in the ABM 
but cannot use destinations at the digital sender until the administrator 
enables your account.

10 To receive e-mail confirmations of e-mail messages you send:

 a Click the user profile you created in the ABM main window.
 b On the File menu, click Properties. 
 c Select the Delivery Notification check box and click OK.

Note To receive confirmations, your e-mail server and the links between your 
e-mail and the recipient’s e-mail must support Delivery Service 
Notification (DSN).
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Introducing the HP Address Book Manager

The HP Address Book Manager (ABM) is a program on your 
computer that allows you to view and alter address books of e-mail 
addresses and fax numbers stored in the digital sender. You access 
these destinations at the digital sender when you want to send a 
document directly to an e-mail address or fax number. You must be a 
registered user to use the ABM.

This is what the ABM main window looks like:

On the left-hand side of the window are the available address books. 
The right-hand side of the window displays the contents of the 
selected address book.

As a registered user, you can see your Private Email and Distribution 
Lists address books. You can view and alter information in both. No 
one else but the administrator can see or access your private address 
books.

You can view the contents of the Public Printers address book. You 
can view and use the contents of the Public Email, Distribution Lists, 
and Fax address books. However, the only public address book you 
and other users can alter is the Public Fax address book. Only the 
administrator can alter all of the public address books. 

The ABM for this digital sender is also the means for using the activity 
log and for switching to view address books for another digital sender. 
For more information about the ABM, see chapter 3, “Using the HP 
Address Book Manager,” which begins on page 49.
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Introducing the HP Digital Sender Link

The HP Digital Sender Link is one of the programs installed with your 
software. This program, which must be running when you send 
documents to your computer, accepts and routes the scanned 
documents. Below is the Control Panel applet for the program, 
showing the Inbox tab:

Using the Control Panel applet, you determine settings for the 
program, such as where to store scanned documents until they are 
opened in a program on your computer. The storage location is 
known as the default inbox location, and the program in which the 
documents are opened is known as the target program. From the 
Control Panel applet, you also set which program is the target 
program. 

The target program can be any program capable of accepting .pdf or 
multipage .tif files. To learn more about choosing a target program 
and other settings, see chapter 4, “Using the HP Digital Sender Link,” 
beginning on page 77.
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Identifying digital sender parts

Before using the digital sender, use the diagram below to familiarize 
yourself with the parts of the digital sender.

Front and top view

Front view with ADF unit raised

Power switch

Document 
output support

Document 
output tray Control

panel

Document
guides

ADF unit 
(raises to 
reveal glass)

Glass
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Identifying control panel features  
Use the following diagram to locate control panel features:

1 Control Panel Display — Displays information and messages.

2 Tab key — Move between fields on the control panel display.

3 Alt key — When used in conjunction with another key, enters the 
letter or symbol on the upper right corner of the other key.

4 Function keys — Each one performs the function displayed 
above the key. In the manuals, these keys are shown in this way: 
KEY.

5 Alphabetic keys — Enter letters and symbols for names, 
passwords, and destinations.

6 Back key — Deletes the last typed character or removes 
destinations from the selection list. In the manuals, this key is 
shown as this symbol: .

7 Enter key — Accepts information on the control panel display or 
moves between fields. In the manuals, this key is shown as this 
symbol: .

8 Scroll Arrow keys — Scroll up and down or through items in a 
field. In the manuals, these keys are shown as these symbols:  
and .

1

4 6 7

5

9 15

14

12

8

2

3

13

10 11
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9 Help key — Activates the Help window, which offers information 
on the selected screen or field. In the manuals, this key is shown 
as this symbol: .

10 Numeric keys — Enter numbers or special characters for your 
language (except English).

11 Special characters sticker — Contains instructions for 
accessing the special characters available for your language 
(except English).

12 Go key — Sends a document. In the manuals, this key is shown 
as this symbol: . 

13 Activity light — Indicates the status of the digital sender. 
(Appears in the outline of the symbol on the Go key.)

14 Cancel key — Stops sending process or returns to the main 
display screen. In the manuals, this key is shown as this symbol: 

.

15 Single-sided/double-sided key — Selects single-sided or 
double-sided original. In the manuals, this key is shown in this 
font: SINGLE-/DOUBLE-SIDED.
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Quick-start tutorial

Use this tutorial to get started with some basic tasks: logging in to the 
ABM and using it to add an e-mail address, loading a document, 
logging in to the digital sender, and e-mailing.

Using the ABM to add an e-mail address
Using the ABM at your computer, you can add e-mail addresses. 
These e-mail addresses are available whenever you want to e-mail 
documents from the digital sender. 

In order to use the ABM, you or the administrator must have 
established your user profile. If you have not already done so, see 
“Adding a registered user profile” on page 13.

To log in to the ABM

Note The digital sender must be on in order for you log in to and use the ABM.

1 On the taskbar, right-click  and choose HP Address Book 
Manager.

2 If the DNS name or IP address for the digital sender you want is 
not in the Digital Sender name field, type it in. Ask the 
administrator if you do not know this information.

3 If your user name is not in the User name field, type it in.

4 In the User password field, type your password (if one is 
defined).

5 Click OK. If all of the login information is valid, the ABM main 
window appears.

6 Go to “To add an e-mail address” below.
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To add an e-mail address

1 In the ABM main window, click the folder for your user name.

2 Click Private Email.

3 On the File menu, click New.

4 In the Name field, type a name for this address.

5 In the E-mail Address field, type the e-mail address.

6 Click Add.

7 When finished, click Close.
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Loading a document

At the digital sender, you can load a 
stack of pages in the ADF and then send 
them to a destination. 

CAUTION
Before using the ADF, remove from the 
document anything such as self-
adhesive notes, paper clips, or staples, 
that could get caught in the digital 
sender and damage it.

To load a document in the ADF

1 Raise the ADF unit and ensure 
nothing is on the glass. Then, close 
the ADF unit.

2 Slide the document (up to 50 pages) 
face up, top first, into the ADF until 
the document stops. Center the 
document between the document 
guides.

3 Adjust the document guides to fit 
snugly against the sides of the stack.

4 If necessary, adjust the output 
support to the correct paper size.

5 Go to “Logging in to the digital 
sender” on page 23.

1

2

3

4
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Logging in to the digital sender
If the main screen appears on the control panel display, guest usage 
is enabled and you do not have to log in. You can go to the next 
section.

If the Digital Sender login screen appears on the control panel 
display, only registered users can use the digital sender. You must log 
in as a registered user before proceeding. Depending on the security 
level, your profile might need to be validated by the administrator 
before you can use it. If this is the case, you will receive an error 
message when you try to log in.

To log in to the digital sender

1 At the HP 9100C Login screen, type your registered user name in 
the NAME field and press .

2 If a password is set in your user profile, type it in the PASSWORD 
field. Your password is case sensitive and must be typed exactly 
as it appears in your user profile.

3 Press .

Once you are logged in as a registered user, you have access to 
control panel functions, the public address books, and your private 
address books. You can also access more detailed activity log 
information using the ABM at your computer.
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E-mailing a document
If you see a function key for e-mail on the main control panel screen, 
you can e-mail a document directly from the digital sender. The main 
screen is the first screen to appear, or it appears after you log in to the 
digital sender.

To e-mail a document

1 Load a document, as described on page 22.

2 Log in (if prompted) and press E-MAIL.

3 If your name is not already entered in the FROM field, type in your 
user name or your e-mail address.

4 Press .

5 If you are a registered user and your user name is password 
protected, a dialog box opens. Type your password and press 

.

6 Type a message in the SUBJECT field (optional).

7 Press .

8 In the TO field, type an e-mail address.
- Or -
Type the name for the e-mail address you added in the “Using the 
ABM to add an e-mail address” section on page 20.

9 Press . The e-mail address, preceded by “To:”, appears in the 
window below the TO field.

10 To CC someone:

 a Press TO. Press  to select CC and press OK.
 b In the CC field, type an e-mail address or choose an e-mail 

destination from an address book. 
 c Press . The destination, proceeded by “CC:”, appears in 

the window below the CC field.

11 Press . The document goes to the e-mail destinations you 
chose.
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Sending to a computer
Use the procedures below to send a document to the target program. 
The first procedure helps you start the HP Digital Sender Link, which 
must be running, and the second procedure helps you send the 
document from the digital sender.

Note Only registered users can send to their computers.

To start the HP Digital Sender Link

At the computer to which you will be sending, make sure the HP 
Digital Sender Link is running and the receive capabilities are 
enabled.

� If you see the icon like this: , then the program is running and 
the receive capabilities are enabled.

� If you see the icon like this: , then the program is running but 
the receive capabilities are disabled. Right-click the icon and 
choose Enable receive.

� If you do not see the icon, the program might or might not be 
running. To check or start the program, click Start, point to 
Programs, then HP 9100C, and then click HP Digital Sender 
Link.

To send to the target program

1 At the digital sender, load the document as described on page 22.

2 Log in (if necessary) and press PC.

3 If your user name is not in the NAME field, type it in.

4 Press  to start sending. 

5 The document goes to your computer and appears as a file in the 
targetprogram.
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Finding help

The rest of this user guide is devoted to helping you use the digital 
sender, the ABM, and the HP Digital Sender Link. This guide will also 
help you troubleshoot if you experience a problem. Additionally, there 
are several other sources of help available to you.

Quick reference guide  

Find information on how to do the most common tasks in this 
convenient booklet. 

Online help for the digital sender

The online help for the digital sender contains context-sensitive help. 
When you press , help appears for the active field on the control 
panel display. For example, if you were sending an e-mail message 
and pressed  while the cursor was in the SUBJECT field, a 
message like this would appear:

Press  again or press CLOSE to exit the online help.

Help

SUBJECT FIELD: Enter the subject of your 
e-mail message here. Press Enter to confirm 
the subject.

ENTER YOUR NAME
FROM:

TO:
SUBJE
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The ABM help

The ABM contains its own help file. To access it, choose a command 
from the Help menu in the ABM main window or any window in which 
the Help menu appears.

HP Digital Sender Link help

If you need help while altering settings in the Control Panel applet for 
the HP Digital Sender Link, choose a command from the Help menu.

Administrator guide

If you cannot find an answer to a question or the resolution to a 
problem in the user guide, quick reference guide, or one of the online 
helps, see the administrator guide or contact the administrator.
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2 Working at the digital 
sender

Introduction

The HP 9100C Digital Sender lets you send a variety of single- and 
double-sided documents to several destinations. This chapter details 
what types of documents you can place in the digital sender, how to 
load them, and how to select settings at the control panel. Then, you 
can send the document to one of the following types of destinations:

� e-mail destinations

� fax destinations

� a printer (to make copies)

� your computer

� JetSend-enabled devices

� If you see function keys for other network destinations or 
programs on the digital sender main screen, you can send 
documents to those programs also. 
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What documents you can place in the digital 
sender

The HP 9100C Digital Sender is both a sheetfed and a flatbed digital 
sender. You can insert a stack of pages (single- or double-sided) into 
the automatic document feeder (ADF) and quickly send them. On the 
glass, you can place documents that you cannot put in the ADF, such 
as pages from books, newspaper clippings, and fragile or lightweight 
documents. 

Guidelines for using the ADF
Using the ADF is a fast, convenient way to send documents. The ADF 
accepts documents that meet the following specifications:

� Documents on standard Letter, A4, and Legal paper.

� Documents can range in size from 148.5 by 210 mm (5.9 by 8.3 
in) to 215.9 by 355.6 mm (8.5 by 14 in).

� Documents can range in weight from 60 to 135 g/m2 (16 to 36 lb).

� Documents should be free of tears, perforations, or punch holes.

� Documents should be square or rectangular and in good 
condition (not fragile or worn).

� Documents should be free of glue, correction fluid, or wet ink.

Avoid multipart forms with carbon pages.

Before placing a document in the ADF, prepare the document by 
doing the following:

� Remove curls or wrinkles. 

� Remove staples, paper clips, paper sticky notes, and any other 
materials from documents.

If your document does not meet these guidelines or you cannot 
prepare it as stated above, send it using the glass. See “Guidelines 
for using the glass” on page 31. 
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Guidelines for using the glass
The glass is the best way to send unusual documents. Examples of 
unusual documents include:

� documents on media lighter than 60 g/m2 (16 lb) or heavier than 
135 g/m2 (36 lb)

� irregular sizes or shapes, such as newspaper clippings, receipts, 
or business cards

� transparencies

� gum-backed paper

� multipart forms with carbon pages

� old or worn photographs or documents

� documents containing tears, perforations, punch holes, wrinkles, 
or curls

Place these types of documents on the glass one at a time and send 
them. 

Note The maximum length the glass can accept is 297 mm (11.7 in). If your 
document is longer but you need to use the glass, send the document 
in multiple sections.

Sending double-sided documents
You can send double-sided documents using the ADF as long as the 
document meets the requirements specified in “Guidelines for using 
the ADF” on page 30. When you send double-sided documents using 
the ADF, all of the odd pages send first, and then all of the even 
pages. In the final document, the pages are in correct order.

You can also send double-sided documents using the glass.

See “Loading a document” on page 32 for instructions on loading a 
double-sided document. Instructions on how to finish sending a 
double-sided document appear at the end of the procedure for 
sending to each type of destination.
EN What documents you can place in the digital sender 31



Loading a document

You can load a stack of pages in the ADF 
or load one page at a time on the glass. 
See “What documents you can place in 
the digital sender” on page 30 if you 
need help determining which method to 
use.

CAUTION
Before using the ADF, remove from the 
document anything such as self-
adhesive notes, paper clips, or staples, 
that could get caught in the digital 
sender and damage it.

To load a document in the ADF

1 Raise the ADF unit and ensure 
nothing is on the glass. Then, close 
ADF unit.

2 Slide the document (up to 50 pages) 
face up, top first, into the ADF until 
the document stops. Center the 
document between the document 
guides.

3 Adjust the document guides to fit 
snugly against the sides of the stack.

4 If necessary, adjust the output 
support to the correct paper size.

5 Set the digital sender to accept your 
single- or double-sided document by 
pressing the SINGLE-/DOUBLE-SIDED 
key until the light under the correct 
icon is lit. 

6 Go to “Logging in” on page 34.

1
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To load a document on the 
glass

1 Raise the ADF unit to reveal the 
glass.

2 Place the page face down on the 
glass, top edge toward the back. 

3 Align the document in the upper-
right corner of the glass.

4 Lower the ADF unit.

5 Go to “Logging in” on page 34.

1

2

3

4
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Logging in

If the main screen appears on the control panel display, guest usage 
is enabled and you do not have to log in. Go to "Taking the next step" 
below.

If the HP 9100C Login screen appears on the control panel display, 
only registered users can use the digital sender. You must log in as a 
registered user before proceeding.

To log in as a registered user

1 At the HP 9100C Login screen, type your registered user name in 
the NAME field and press .

2 If a password is set in your user profile, type it in the PASSWORD 
field. Your password is case sensitive and must be typed exactly 
as it appears in your user profile.

3 Press .

Once you are logged in as a registered user, you have access to 
control panel functions, the public address books, and your private 
address books. You can also access more detailed activity log 
information using the ABM at your computer.

Taking the next step

Before proceeding, read “Changing settings” on page 35 if you are 
not familiar with how to set the Size and Quality settings. Then, go to 
one of the following sections to choose a delivery option:

� E-mailing documents

� Faxing documents

� Copying documents

� Sending to a computer

� Sending to another program (if enabled by the administrator)

� Sending to an HP JetSend-enabled device
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Changing settings

After you select a destination, the default or current Quality setting 
appears in the upper right corner of the control panel display. If this 
setting is not correct for the document you are sending, or if you need 
to check the (paper) Size setting, use the procedures below.

Selecting the Size setting
You can choose Letter, A4, or Legal size. If the document you are 
sending is an irregular size, choose the option that most closely 
matches.

To select the Size setting

1 Press SETTINGS. The current Quality setting appears.

2 Press  until the Size options appear.

3 Using the  and  keys, choose A4, Letter, or Legal.

4 Press OK to save the selection and exit the Settings screen.
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Selecting the Quality setting
The table below shows the Quality setting options. Choose the option 
that most closely matches the type of document you have. For 
example, if you were faxing a report containing a color pie chart, you 
would choose the Color Document setting. Even though the 
document is not faxed in color, it is faxed with the best quality for that 
type of document.

To select the Quality setting

1 Press SETTINGS. The current Quality setting appears.

2 Using the  and  keys, choose an option. (If you continue 
pressing the , you scroll the options for the Size setting.)

3 Press OK to save the selection and exit the Settings screen.

Use this setting For this type of document When doing this 
function

Color Document The original has a mix of text and images.
Or, the original has a mix of color and black-and- 
white areas. 

E-mailing
Faxing
Copying
Sending to a PC
Sending to another program
Sending to an HP JetSend- 

enabled device

B/W Document The original contains text that must be clearly 
transmitted. Or, the original is black and white.

E-mailing
Faxing
Copying
Sending to a PC
Sending to another program
Sending to an HP JetSend-

enabled device

Color-B/W Photo The original is a photograph. 
Or, it is most important that the colors or shades of 
gray in an image be clear.

E-mailing
Faxing
Copying
Sending to a PC
Sending to another program
Sending to an HP JetSend-

enabled device

Fine Text (OCR) The original contains text that needs to be 
converted to editable text using OCR software.

Sending to another program

Hi-Res Color-B/W Photo The original is a photograph or graphic that needs 
to be reproduced.

Sending to another program
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E-mailing documents

If you see a function key labeled E-MAIL on the main screen, you can 
send documents directly to e-mail destinations. When you e-mail from 
the digital sender, it creates a message and attaches your document 
as a .pdf file.

When you e-mail from the digital sender, the TO, SUBJECT, and 
FROM fields appear. You must enter destinations in the TO field, and 
you can change to the CC field to enter destinations. You can also 
enter a message in the SUBJECT field. If you do not, a default 
message set by the administrator might appear in that field.

Depending on the security level set by the administrator, you may be 
able to change the text in the FROM field, or it might be filled with a 
name you cannot alter. 

Hint If you want to add text notes to the document before e-mailing it, send 
it to the target program first. Then, you can e-mail it from your computer. 
See “Sending to a computer” on page 44 for more information.

Choosing e-mail destinations

You can choose e-mail destinations at the digital sender in one or 
both of the following ways:

� Type the e-mail address manually.

� Begin typing the name for an e-mail address or distribution list 
stored in the public address books or your private address books. 
As you type, the digital sender completes the name.

� Begin typing an e-mail destination stored on an LDAP server. If 
the administrator has configured the digital sender to work with 
that LDAP server, the SEARCH key appears. Press SEARCH and 
select the destination from the list that is presented. Or, press 
SHIFT+SEARCH to access advanced search options.

If too many matching entries are found, you receive a message. 
Press CANCEL to scroll the partial list of addresses found. Or, you 
can further narrow the search and try again.
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To send to e-mail destinations

Note At any time before pressing  to send the document, you can press 
 or BACK to return to the main screen without saving any settings.

1 Log in (if prompted) and press E-MAIL.

2 If your name is not already entered in the FROM field, type in your 
user name or your e-mail address.

3 Press .

4 If you are a registered user and your user name is password 
protected, a dialog opens. Type your password and press .

5 To add a message to the SUBJECT field, type one.

6 Press . 

7 To add an e-mail destination or distribution list to the TO field:

• Type the actual address.

• Begin typing the name of an e-mail address or distribution list 
stored in an address book. As you type, the digital sender 
completes the name.

• Begin typing an e-mail address stored in an LDAP server. 
Then, press SEARCH, use the  and  keys to select the 
address you need, and press OK. 

8 Press . The destination, preceded by “To:”, appears in the 
window below the TO field.

9 Repeat steps 6 and 7 until all the destinations you want are listed 
in the window below the TO field. Use the  and  keys to view 
the list.

Note If you need to remove an e-mail destination from the list, press  to 
enter the list field, select the destination using the  and  keys, and 
press .
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10 To CC someone:

 a Press TO. Press  to select CC and press OK.
 b In the CC field, type an e-mail address or choose an e-mail 

destination from an address book. 
 c Press . The destination, preceded by “CC:”, appears in 

the window below the CC field.

11 The current Quality setting is shown in the upper right corner of 
the display. For options and instructions on changing this setting 
or the (paper) Size setting, see “Changing settings” on page 35.

12 Press  to begin sending the document.

• If you sent a single-sided document using the ADF, the 
process is finished.

• If you sent a double-sided document using the ADF, wait for 
the first side to finish. Then, reload the document with the 
second side facing up, last page on top, and press  again.

• If you used the glass, remove the page when it is finished. 
Then, place the next page face down on the glass and press 

. After the last page, press SEND.

Note Your company’s e-mail server, not the digital sender, is what validates 
the e-mail addresses you are sending to. The digital sender does not 
notify you if you sent to an invalid address, but the activity log does. 
See “Using the activity log” on page 70.

Reading .pdf file attachments

The recipient of your e-mail message containing a .pdf file attachment 
can read the file using Adobe’s Acrobat Reader. Many people already 
have this program. If your recipients do not have Reader, they can 
download a free copy of it for Windows or Macintosh from Adobe’s 
website at www.adobe.com.

After installing Reader, Windows users can read .pdf files by double-
clicking them. Macintosh users can read .pdf files by opening Reader, 
choosing Open on the File menu, and then selecting the file.
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Faxing documents

If you see a function key labeled FAX on the main screen, you can 
send documents to fax destinations directly from the digital sender. 
You can choose fax destinations in one or both of the following ways:

� Type fax numbers manually.

� Begin typing the name for a fax destination stored in the Public 
Fax address book. As you type, the digital sender completes the 
name.

If you are a registered user, you can also request e-mail notification of 
the fax transmission. (This feature only works if your company’s LAN 
fax program supports notification and the administrator has enabled 
it.)

Hint If a LAN fax program is not installed on your network but you have a 
fax program on your computer, send the document to the target 
program. Then, you can send the fax from there. (This assumes that 
the fax program is compatible with the target program.) See “Sending 
to a computer” on page 44 for more information.

Also send to the target program if you want to add text notes to a 
scanned document before PC faxing it. 

To fax documents

Note At any time before pressing  to send the document, you can press 
 or BACK to return to the main screen without saving any settings.

1 Log in (if prompted) and press FAX.

2 To enter a fax number in the FAX field:

• Type the fax number.

• Type the name of a fax destination stored in the Public Fax 
address book. As you type, the digital sender completes the 
name.
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3 Press . The fax number or destination you chose appears in 
the window below the FAX field.

4 Repeat steps 2 and 3 until all the fax numbers you want are listed 
in the window below the FAX field. (You can add a maximum of 
64 destinations.) Use the  and  keys to view the list.

Note To remove a fax destination from the list, press  to enter the list field, 
select the fax destination using the  and  keys, and press .

5 If you are a registered user and want to receive an e-mail 
notification of the fax transmission, press  until you enter the 
NOTIFY field and type your user name (if it is not already 
entered).

6 The current Quality setting is shown in the upper right corner of 
the display. For options and instructions on changing this setting 
or the (paper) Size setting, see “Changing settings” on page 35.

7 Press  to begin sending the document.

• If you sent a single-sided document using the ADF, the 
process is finished.

• If you sent a double-sided document using the ADF, wait for 
the first side to finish. Then, reload the document with the 
second side facing up, last page on top, and press  again.

• If you used the glass, remove the page when it is finished. 
Then, place the next page face down on the glass and press 

. After the last page, press SEND.

If fax destinations are busy, the numbers are retried as many times as 
are specified by the LAN fax program.

Note Your company’s LAN fax server, not the digital sender, is what validates 
the fax numbers you are sending to. The digital sender does not notify 
you if you sent to an invalid address, but the activity log does. See 
“Using the activity log” on page 70.
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Copying documents

If you see a function key labeled COPY on the main screen, you can 
send documents to a network printer to make copies. Convenience 
copying works only with printers the administrator has configured for 
use with the digital sender.

Keep the following in mind when sending documents to a printer to 
make copies:

� The HP 9100C Digital Sender can send to only one printer at a 
time.

� More than one copy of a document can be sent, but the copies 
cannot be collated. When sending multiple copies, all the first 
pages print, then all of the second pages, and so on.

� Only some color printers can print color documents sent from the 
digital sender. If you have a color printer, check with the 
administrator to see if it can print color documents sent from the 
digital sender.

Hint If you want to print collated copies or do not have a color network printer 
available to print color copies, send the document to the target program 
and print it from there. See “Sending to a computer” on page 44. 
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To copy documents

Note At any time before pressing  to send the document, you can press 
 or BACK to return to the main screen without saving any settings.

1 Log in (if prompted) and press COPY.

2 Using the  and  keys, choose the printer where you want to 
print the copies and press .

3 In the Copies field, type the number of copies you want to make. 

4 The current Quality setting is shown in the upper right corner of 
the display. For options and instructions on changing this setting 
or the (paper) Size setting, see “Changing settings” on page 35.

5 Press  to begin sending the document.

• If you sent a single-sided document using the ADF, the 
process is finished.

• If you sent a double-sided document using the ADF, wait for 
the first side to finish. Then, reload the document with the 
second side facing up, last page on top, and press  again.

• If you used the glass, remove the page when it is finished. 
Then, place the next page face down on the glass and press 

. After the last page, press SEND.
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Sending to a computer

If you see a function key labeled PC on the main screen, you can 
send documents to a computer. 

Remember the following important points:

� You can send only to computers of users who have registered 
user profiles. (For example, if you are not a registered user, you 
cannot send a document to your computer.)

� The HP 9100C Digital Sender can send to only one person’s 
computer at a time.

� The computer to which you are sending must be on and the 
Digital Sender Link on it must be running and enabled.

To start the HP Digital Sender Link 

At the computer to which you will be sending, make sure the HP 
Digital Sender Link is running and the receive capabilities are 
enabled.

� If you see the icon like this: , then the program is running and 
the receive capabilities are enabled.

� If you see the icon like this: , then the program is running but 
the receive capabilities are disabled. Right-click the icon and 
choose Enable receive.

� If you do not see the icon, the program might or might not be 
running. To check or start the program, click Start, point to 
Programs, then HP 9100C, and click HP Digital Sender Link.

If the program is running but the icon is hidden, you can check if 
the receive capabilities are enabled by double-clicking the HP 
Digital Sender Link icon in Windows Control Panel. Click the 
Inbox tab, and make sure the Enable receive check box is 
selected.
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To send to your computer

Note At any time before pressing  to send the document, you can press 
 or BACK to return to the main screen without saving any settings.

1 At the digital sender, log in (if prompted) and press PC.

2 If your name is in the NAME field, go to the next step.
- Or -
Type your name in the NAME field. (If you want to send to another 
user’s computer, type the name of that user.)

3 The current Quality setting is shown in the upper right corner of 
the display. For options and instructions on changing this setting 
or the (paper) Size setting, see “Changing settings” on page 35.

4 Press  to begin sending the document.

• If you sent a single-sided document using the ADF, the 
process is finished.

• If you sent a double-sided document using the ADF, wait for 
the first side to finish. Then, reload the document with the 
second side facing up, last page on top, and press  again.

• If you used the glass, remove the page when it is finished. 
Then, place the next page face down on the glass and press 

. After the last page, press SEND.

When the document arrives at your computer, it becomes a saved file 
in your default inbox location. View and work with the document in the 
target program or another program that accepts the file type specified 
in your user profile.
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Sending to another program

If function keys are labeled for use with network storage locations, 
you can send documents to those destinations and use the 
documents with specified programs. 

To send to another program

Note At any time before pressing  to send the document, you can press 
 or BACK to return to the main screen without saving any settings.

1 At the digital sender, log in (if prompted).

2 Press the function key for the destination you want. (It is named 
whatever the administrator chose.) If the destination is not on the 
bottom row of the display, use the  and  keys to move it to the 
bottom row.

3 Use the  and  keys to select a secondary destination from the 
list.

4 The current Quality setting is shown in the upper right corner of 
the display. For options and instructions on changing this setting 
or the (paper) Size setting, see “Changing settings” on page 35.

5 Press  to begin sending the document.

• If you sent a single-sided document using the ADF, the 
process is finished.

• If you sent a double-sided document using the ADF, wait for 
the first side to finish. Then, reload the document with the 
second side facing up, last page on top, and press  again.

• If you used the glass, remove the page when it is finished. 
Then, place the next page face down on the glass and press 

. After the last page, press SEND.
46   Chapter 2 - Working at the digital sender EN



Sending to an HP JetSend-enabled device

If you see a function key labeled JETSEND, you can send documents 
to JetSend-enabled devices.

HP JetSend is a communications technology built into printer and 
scanner firmware and computer software. HP JetSend-enabled 
devices can connect, “talk” to each other, and exchange information 
directly from the network. It is server- and program-independent. 

The digital sender is an HP JetSend-enabled device. You can use its 
HP JetSend capabilities with the following types of devices:

� printers on your company intranet that are HP JetSend enabled.

� computers with HP JetSend for Windows software installed. You 
can download a free copy of the HP JetSend for Windows 
software for Windows NT or 95 from the HP JetSend website at 
www.jetsend.hp.com.

Both types of devices must also have valid TCP/IP addresses.

Choosing or adding HP JetSend-enabled 
devices
When you press JETSEND at the digital sender, a list of HP JetSend-
enabled devices appears. (The list contains up to 64 devices.) You 
can choose a device from the list, or you can add a device.

To add a device to the list

1 Press JETSEND. The list of HP JetSend-enabled devices appears.

2 Press NEW.

3 Type the DNS name or IP address for the HP JetSend-enabled 
device you want to add. If you do not know this information, check 
with the administrator.

4 Press OK. The device is added to the list. 

Note Once the list contains 64 devices, the NEW key disappears. Before 
adding more devices, you must delete at least one existing device from 
the list. To delete a device, use the  and  keys to select it and press 
DELETE.
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To send to an HP JetSend-enabled device

Note At any time before pressing  to send the document, you can press 
 or BACK to return to the main screen without saving any settings.

1 At the digital sender, log in (if prompted).

2 Press JETSEND.

3 To choose an HP JetSend-enabled device:

• Use the  and  keys to select a device from the list and 
press .

• Add a new device to the list. (See “To add a device to the list” 
on page 47.)

4 The current Quality setting is shown in the upper right corner of 
the display. For options and instructions on changing this setting 
or the (paper) Size setting, see “Changing settings” on page 35.

5 Press  to begin sending the document.

• If you sent a single-sided document using the ADF, the 
process is finished.

• If you sent a double-sided document using the ADF, wait for 
the first side to finish. Then, reload the document with the 
second side facing up, last page on top, and press  again.

• If you used the glass, remove the page when it is finished. 
Then, place the next page face down on the glass and press 

. After the last page, press SEND.

Sending the next document

After you have successfully sent a document, the control panel 
returns to the function screen (such as e-mail or fax) that you just 
used and displays the current settings again. If you have another 
document to send to the same function, load the document, choose 
new destinations, and press .

You can return all settings to the defaults and choose a different 
function by pressing . You return to the main screen.
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3 Using the HP Address 
Book Manager

Introduction

You can use the HP Address Book Manager (the ABM) as long as it is 
installed on your computer and you have registered user status. Use 
the ABM to do the following:

� view information in public and your private address books

� change information in the Public Fax address book

� add or change your registered user profile

� change information in your private address books

� change the appearance of the ABM on your computer

� use the activity log

� back up and restore your private address books

� use the ABM for another digital sender
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Introduction to the address books

The the ABM contains the following address books:

� Your address book
Inside your address book are your private e-mail address book 
and private address book of e-mail distribution lists. No one 
except you and the administrator can see or change your private 
address books.

� Public Email
Contains e-mail addresses available to any user. Only the 
administrator can change information in this address book.

� Public Distribution Lists (e-mail)
Contains predefined groups of e-mail addresses available to any 
user. Only the administrator can change information in this 
address book.

� Public Fax
Contains fax destinations available to any user. You, other 
registered users, and the administrator can change information in 
this address book.

� Public Printers
Contains the network printers you can access from the digital 
sender to make copies of a document. Only the administrator can 
change information in this address book.

Destinations in the public and your private address books are 
accessed at the digital sender when you want to fax or e-mail a 
document.
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Your user profile

There are two different types of users for the digital sender: 
registered users and guest users. Registered users must establish a 
user profile, and they have full access to all features. Guest users do 
not have to establish a user profile, but they also do not have full 
access to all features.

Registered users

As a registered user, you have the following privileges.

� You can use the digital sender even if the administrator disables 
guest usage. 

� You can send documents to your computer. Without a registered 
user profile, you cannot send to your computer.

� You can use the ABM program. In the ABM, you will have a 
Private Email address book and a Private Distribution Lists 
address book, where you can store often-used addresses and 
lists for use at the digital sender.

� In the ABM, you have rights to add, change, and delete fax 
destinations in the Public Fax address book. 

� You see information in the activity log under your name. When 
using the digital sender as a guest user, you cannot tell your 
activity from the activity of any other guest user.

� You can have the digital sender send you e-mail notifications of 
the status of faxes or e-mail messages you send from the digital 
sender. (Your e-mail and LAN fax programs must support 
notification.)

To become a registered user, see “Adding a new registered user 
profile” on page 52.
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Guest users

If you are a guest user, you cannot use the digital sender if the 
administrator disables guest usage. 

If guest usage is enabled, you can use the digital sender and choose 
destinations in the Public Email, Distribution Lists, and Fax address 
books. However, you do not have Private Email and Distribution Lists 
address books. You also cannot use the ABM to alter information in 
any address books or for any other purpose.

As a guest user, you cannot send documents to your computer. And, 
you cannot receive e-mail notification of the status of faxes or e-mail 
messages you send from the digital sender.

Adding a new registered user profile
If the administrator has already set up your registered user profile, or 
if you have already done it, you do not need to add your registered 
user profile again. If you do not already have a registered user profile, 
see “Adding a registered user profile” on page 13.
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Changing an existing user profile
In your own registered user profile, you can change your password, 
the notification status for e-mail messages, and the file format that 
documents received to your computer will have. You can also change 
your user name, computer address, and e-mail address, but these 
changes might require administrator approval before they are 
implemented. 

Two parts of your user profile, the Account Enable and Add E-mail 
Address to Public Address Book check boxes, are only available to 
the administrator.

Note One of the fields you can change is the Password field. You do not 
have to specify a password. However, if you do not have a password, 
other users can log in at the digital sender with your name, access your 
private address books, and send e-mail messages using your name.

To change an existing user profile

1 Log in to the ABM. (See “Starting the HP Address Book Manager” 
on page 54.)

2 In the ABM main window, click the folder for your user name.

3 On the File menu, click Properties.

4 To set the file type that documents sent to the computer have as a 
default, type .pdf or .tif in the File Format field.

5 To receive e-mail confirmation of e-mail messages you send from 
the digital sender, select the Delivery Notification check box.

Note To receive confirmations, your e-mail server and the links between your 
e-mail and the recipient’s e-mail must support Delivery Service 
Notification (DSN).

6 Make changes to any other fields as necessary.

7 Click Change to confirm the changes.
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Starting the HP Address Book Manager

When you start the ABM, a dialog box appears that requires you to 
log in. You will need to know the DNS name or Internet protocol (IP) 
address of the digital sender you use. In addition, you must be a 
registered user.

If you have never used the ABM before, you must add yourself as a 
registered user or have the administrator do it. See “Adding a 
registered user profile” on page 13.

To start the ABM and log in

Note The digital sender must be on in order for you log in to and use the ABM.

1 Start the ABM in one of the following ways:

• Click Start, point to Programs, then HP 9100C, and click HP 
Address Book Manager. 

• If the HP Digital Sender Link icon is showing in the taskbar, 
right-click it and choose HP Address Book Manager.

2 If the DNS name or IP address for the digital sender you want is 
not in the Digital Sender name field, type it or choose it from the 
list.

3 If your user name is not in the User name field, type it or choose 
it from the list.

4 In the User password field, type your password (if one is 
defined).

5 Click OK. If all of the login information is valid, the ABM main 
window appears.
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Working in the ABM main window

Once you have successfully logged in to the ABM, the ABM main 
window appears:

The ABM main window shows the folders for both the public and your 
private address books. The main window is set up with a splitter bar 
showing all the files in the ABM on the left and the contents of a 
selected file on the right.

From this screen, you can access and view the public and your 
private address books. You can change information in the Public Fax 
address book and your private e-mail and distribution lists address 
books. 
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Managing your Private Email address book

If you are a registered user, e-mail addresses in your Private Email 
address book are available when you are e-mailing a document 
directly from the digital sender. You can also use these addresses, 
along with those in the Public Email address book, to build distribution 
lists of people to whom you regularly e-mail the same information. 

Note If information for an address in the Public Email address book needs 
to change, contact the administrator. You can view and use information 
in the Public Email address book, but you cannot change it.

Adding addresses
As a registered user, you can add up to 256 e-mail addresses to your 
Private Email address book. You might not want to add e-mail 
addresses to your Private Email address book if they already appear 
in the Public Email address book. E-mail addresses in the Public 
Email address book are always available for your use. 

Note You can also import e-mail addresses from certain e-mail programs or 
LDAP servers. See “Importing addresses from an e-mail program” on 
page 57 or “Importing e-mail addresses from an LDAP server” on 
page 58.

To add addresses manually

1 In the ABM main window, click the + next to the folder for your 
user name to expand it.

2 On the left side of the window, click Private Email.

3 On the File menu, click New.

4 In the Name field, type a name for this address.

5 In the Email Address field, type the e-mail address.

6 Click Add.

7 To add more addresses, repeat steps 4 through 6.

8 When finished, click Close to return to the main window.
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Importing addresses from an e-mail program
You can import e-mail address from certain e-mail programs into your 
Private Email address book. Then, the addresses will be available 
when you e-mail directly from the digital sender, and you can use 
them to build distribution lists. In order to be able to import addresses, 
your e-mail program must be capable of exporting the addresses into 
one of the following types of files: comma separated value (CSV), 
LDAP Data Interchange Format (LDIF), or Microsoft Exchange 5.0.

To import addresses from an e-mail program

1 Open your e-mail program and do the following:

 a Choose the Export command. 

 b Save your address book in a CSV, LDIF, or MS Exchange 5.0 
file format. (If you need more help exporting your address 
book, see the documentation for your e-mail program.)

 c Close your e-mail program.

2 Open the ABM.

3 In the ABM main window, click the + next to the folder for your 
user name to expand it.

4 On the left side of the window, click Private Email.

5 On the Tools menu, click Address Book Import.

6 In the Import dialog box, choose the file format in which you 
saved your e-mail program’s addresses.

7 Click Import.

8 Select the file you saved in step 1 and click Open.

9 If you selected a CSV file format, another dialog box opens. 
Follow the instructions on the screen to select the correct name 
and address line. If there is a first line that only contains the 
names of the fields, clear the Import first line check box. Then, 
click Import.

The file imports into your Private Email address book. 
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Importing e-mail addresses from an LDAP 
server
You can import e-mail addresses located on an LDAP server into your 
Private Email address book.

There are two parts to this procedure: Configuring the directory for 
the e-mail addresses, and then searching for and selecting the e-mail 
addresses you want. You only have to configure the directory once. 
Then, you can search the directory regularly to update the addresses 
from the LDAP server to your Private Email address book.

Hint If your administrator has configured the digital sender to work with the 
LDAP server, you can access the addresses on the LDAP server 
directly from the digital sender and do not need to import them to your 
Private Email address book. (See “E-mailing documents” on page 37.) 
You probably only want to import addresses from the LDAP server into 
your Private Email address book if you want to use the addresses in 
your private distribution lists or your administrator hasn’t configured the 
LDAP server to work with the digital sender.

To define directories

Note In order to import e-mail addresses from another location on the 
network, you first have to let the ABM know where the e-mail addresses 
are located by defining a directory. 

1 On the Tools menu in the ABM main window, point to Directory 
Services, and then click Config.

2 In the Directories Configuration dialog box, click New.

3 In the Directory Name field, type a name for the directory.

4 In the Server Name field, type the DNS name or IP address for 
the server that maintains the directory. Contact the administrator 
if you do not know this information.

5 Depending on the server, you may need to type the basepoint 
from which to start the search in the Search Root field. Contact 
the administrator for this information.
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6 In the Port Number field, type the TCP/IP number for the 
directory server. Contact the administrator for this information.

7 In the Maximum number of hits field, type the maximum number 
of results you want the search to return. If the number is set to 
zero, the search returns all entries that match the search criteria. 

Note Some servers might have a default limit. If the maximum you specify is 
larger than the server limit, you receive an error message, and the 
search returns as many matches as it can. To determine the server 
limit, count the number of returned entries or ask the administrator.

8 In the Timeout field, type the amount of time (in minutes) that you 
want the search to continue. If this number is set to zero, the 
timeout of the server is used.

9 Check with the administrator to see if the directory server 
requires an authenticated login. Then, do one of the following.

• If the directory server requires an authenticated login, choose 
Password in the Authentication Type field. Enter the User 
Name and Password, and then confirm the password by 
retyping it in the Confirm field.

• If the directory server does not require an authenticated login, 
choose Anonymous in the Authentication Type field.

10 Click OK.

11 To begin searching and adding e-mail addresses, go to “To 
search a directory and import addresses” on page 60.
- Or -
If you need to change something in the directory configuration 
before searching, go to the next procedure.
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To change or delete directories

1 On the Tools menu in the ABM main window, point to Directory 
Services, and then click Config.

2 In the Directories Configuration dialog box, select the directory 
you want to change or delete.

3 Do one of the following:

• To change the directory: Click Edit. Make changes in the 
Directory Server Configuration dialog box and click OK.

• To delete the directory: Click Delete and then click Yes.

To search a directory and import addresses  

1 On the Tools menu in the ABM main window, point to Directory 
Services, and click Search.

2 In the In field, select the directory you want to search. You must 
have already defined this directory.

3 In the Name and Email Address fields, type any criteria you 
want to use for finding destinations. The criteria can be names, 
addresses, or both. (You can enter partial names and addresses.) 
You can further narrow the search by using “begins with,” 
“contains,” “ends with,” or “is.”

4 If you want the search to skip duplicate destinations, click Skip in 
the Duplicated Names box.

5 Click Find. Results are listed in the Name/Email Address box.

6 Do one of the following.

• To add all of the found addresses, click Add all.

• To add only some of the addresses, click the first address you 
want and click Add. Repeat for each address you want.

• To clear the search results, click Clear and repeat this 
procedure.

Unless you cleared the search, the addresses you selected are 
imported into your Private Email address book. If you have used 
these addresses in your private distribution lists, the addresses are 
automatically updated in the lists in which they appear.
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Changing e-mail addresses
Once you have added or imported addresses to your Private Email 
address book, you can change the name and e-mail information. 
Changing this information also changes it in any of your private 
distribution lists where it appears.

Renaming addresses can be very time consuming because the ABM 
looks for duplicates before renaming.

To change e-mail addresses

1 In the ABM main window, click the + next to the folder for your 
user name to expand it.

2 On the left side of the window, click Private Email.

3 Click the e-mail destination you want to change.

4 On the File menu, choose Properties. 

5 Change the name, e-mail address, or both items.

6 Click Change.

Note You can also change the name of a destination by clicking on the 
destination, changing the name, and pressing ENTER.
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Deleting addresses
If an e-mail address in your Private Email address book is no longer 
useful, you can delete it. Deleting an address from this address book 
also deletes it from any of your private distribution lists where it 
appears.

To delete addresses

1 In the ABM main window, click the + next to the folder for your 
user name to expand it.

2 On the left side of the window, click Private Email.

3 Click the e-mail destination you want to delete.

4 On the File menu, click Delete.

5 A dialog box appears. Click Yes to confirm the deletion.
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Managing your private distribution lists

Your Private Distribution Lists address book contains distribution lists 
of e-mail addresses you create. It is useful to build a distribution list if 
you regularly send e-mail to the same group of people. 

Distribution lists can only consist of e-mail addresses. You cannot 
create distribution lists containing both e-mail addresses and fax 
destinations or distribution lists of only fax destinations.

Note If information in the Public Distribution Lists address book needs to 
change, contact the administrator. You can view and use information 
in the Public Distribution Lists address book, but you cannot change it.

Creating lists
In your Private Distribution Lists address book, you can create 
distribution lists of e-mail addresses you use regularly. You can create 
distribution lists using e-mail addresses from both the Public Email 
address book and from your Private Email address book.

You might not want to create a private distribution list if there is one 
just like it in the Public Distribution Lists address book. Public 
distribution lists are always available for your use.

To create lists

1 In the ABM main window, click the + next to the folder for your 
user name to expand it.

2 Click Private Distribution Lists.

3 On the File menu, click New.

4 A new folder called New List appears in List view. In the selected 
box, type the name for the distribution list and press ENTER.
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Adding and deleting addresses in lists
Once you have created a private distribution list, you can add e-mail 
addresses to it or remove e-mail addresses from it. 

To add addresses to lists

1 In the ABM main window, open the folder that contains the 
addresses you want to add to a list. These addresses can come 
from one of your private or the public e-mail or distribution lists 
address books.

2 Select the address or addresses you want to add to a distribution 
list. 

Note To select multiple, consecutive addresses, hold down SHIFT as you 
select the first and last addresses of the range you want. Select 
multiple, non-consecutive addresses by holding down CTRL as you click 
each address you want.

3 On the Edit menu, choose Copy.

4 If you are not already in the folder for your user name, click the + 
next to it to expand it.

5 Click the + next to Private Distribution Lists to expand it.

6 Click the distribution list to which you want to add the names.

7 On the Edit menu, choose Paste. The new destinations are 
added to the list.

To delete addresses from lists

1 In the ABM main window, click the + next to the folder for your 
user name to expand it.

2 Click the + next to Private Distribution Lists to expand it.

3 Click the distribution list you want.

4 Select the address or addresses you want to delete.

5 On the File menu, click Delete.

6 A dialog box appears. Click Yes to confirm the deletion.
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Changing addresses in lists
If the information for an address in one of your private distribution lists 
needs to change, it must be changed from the e-mail address book 
where the address is located.

If the address that needs to change is from your Private Email 
address book, see “Changing e-mail addresses” on page 61. If the 
address is from the Public Email address book, contact the 
administrator to make changes. 

Once the address has been changed, it is also automatically updated 
in any distribution list in which it appears.

Deleting lists
If they are no longer useful, you can delete distribution lists from your 
Private Distribution Lists address book.

To delete lists

1 In the ABM main window, click the + next to the folder for your 
user name to expand it.

2 Click the + next to Private Distribution Lists to expand it.

3 Click the distribution list you want to delete.

4 On the File menu, click Delete.

5 A dialog box appears. Click Yes to confirm the deletion.
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Working with fax destinations

If you can see the Public Fax address book in the ABM main window, 
then your company has a LAN fax program and it is configured for use 
with the digital sender. You can access the Public Fax address book 
and add, change, or delete fax destinations.

Adding fax destinations
If you use certain fax numbers regularly, you can add them to the 
Public Fax address book. Then, you can fax directly to these 
preprogrammed numbers from the digital sender. 

Note When adding a new destination, you see an Accounting Code field. 
The administrator determines the accounting code, and you cannot see 
or change the code. (The accounting code is only supported by a few 
LAN fax programs.)

To add fax destinations

1 In the ABM main window, click Public Fax.

2 On the File menu, click New.

3 In the Name field, type a name for the fax destination.

4 In the Phone Number field, type the telephone number for the fax 
destination.

5 Click Add.

6 To add more fax destinations, repeat steps 3 through 5.

7 When finished, click Close.
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Changing fax destinations
You can change the names and fax numbers of destinations in the 
Public Fax address book, unless the destination has an accounting 
code specified. In that case, only the administrator can change 
information for that destination.

To change fax destinations

1 In the ABM main window, click Public Fax.

2 Click the destination you want to change.

3 On the File menu, click Properties.

4 Change the name, fax number, or both items.

5 Click Change.

Note You can also change the name of a destination by clicking on the 
destination, changing the name, and pressing ENTER.

Deleting fax destinations
You can delete fax destinations from the Public Fax address book, 
unless there is an accounting code specified. In that case, only the 
administrator can delete the destination.

CAUTION If you can delete destinations, do not delete any that other users might 
need. This is a public address book, and removing a fax destination 
from it makes the destination unavailable to all users. 

To delete fax destinations

1 In the ABM main window, click Public Fax.

2 Click the fax destination you want to delete.

3 On the File menu, click Delete.

4 A dialog box appears. Click Yes to confirm the deletion.
EN Working with fax destinations 67



Finding names in address books

If you need to find an e-mail or fax destination in an address book but 
do not know where it is, you can use the Find function in the ABM. 

The ABM allows you to search for a name in:

� the Public Fax address book

� the Public Email address book

� the Public Distribution Lists address book

� your Private Email address book

� your Private Distribution Lists address book

You cannot search for e-mail addresses in other users’ private 
address books. 

To find names in address books

1 In the ABM main window, open the address book in which you 
want to search for an e-mail address or fax destination.

2 On the Tools menu, click Find.

3 In the Name field, type the name or part of the name you are 
searching for. 

4 If you only want to find names that exactly match what you typed, 
select the Match whole word only check box.

5 Click Find Next. The first entry that matches your criteria moves 
to the top of the address book.

6 Click Cancel to close the dialog box.
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Copying and moving addresses and lists

Using the Cut, Copy, and Paste commands, you can do the following 
with e-mail addresses:

� Copy e-mail addresses from the Public Email address book to 
your private e-mail address book.

� Copy e-mail addresses from the Public Email address book to 
one of your private distribution lists.

� Copy distribution lists from the Public Distribution Lists address 
book into your Private Distribution Lists address book.

� Copy e-mail addresses from your Private Email address book to 
one of your private distribution lists.

� Move or copy addresses from one of your distribution lists to 
another.

You cannot move e-mail addresses from your private e-mail or 
distribution list address books into the public address books. Also, 
you cannot move fax numbers from the Public Fax address book to 
any other address book. 
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Using the activity log

The activity log is a record of digital sender use. Every time someone 
uses the digital sender, a record is filed in the activity log. You do not 
see a record of digital sender usage by other registered users or the 
administrator.

You can view the log, save it to a separate file, print it, or clear it.

Viewing the activity log
You can access the activity log to see what you and guest users have 
distributed. The activity log contains entries for the last 100 uses.

Note For a description of activity log messages, see “Activity log messages” 
on page 103.

To view the activity log

1 On the Tools menu in the ABM main window, point to View Log.

2 Click your user name to see only your activity as a registered 
user.
- Or -
Click Guest to see the activity of guest users. (If you do not have 
to log in at the digital sender, your activity might be included in 
this log.) 

The activity viewer appears with a record of digital sender activity. 
The status bar at the bottom of the window displays information 
about how many messages of a certain type appeared.

3 You can sort the log according to description and severity of the 
message, date, or time by clicking the column header.

4 You can keep the activity viewer open while you work in the ABM. 
To close the activity viewer, on the File menu, click Exit.
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Saving or copying the activity log
You can save the whole activity log to a file or copy specific entries to 
the Windows clipboard and paste them into a document in another 
program.

To save the whole activity log

1 On the Tools menu in the ABM main window, point to View Log, 
and click your user name or Guest.

2 On the File menu in the ABM main window, click Save As.

3 In the Save As dialog box, save the file as one of the following:

• Text (plain) .txt to use the information in general-purpose 
programs.

• Text (tab delimited) .txt or .csv (comma delimited value) for 
importing into tables and spreadsheets.

• HTML .html for web publishing and e-mail communications.

4 You can keep the activity viewer open while you work in the ABM. 
To close the activity viewer, on the File menu, click Exit.

To copy selected entries to the clipboard

1 On the Tools menu in the ABM main window, point to View Log, 
and click your user name or Guest.

2 Select one or more entries to save.

Note To select multiple, consecutive entries, hold down SHIFT as you select 
the first and last entries of the range you want. Select multiple, non-
consecutive entries by holding down CTRL as you click each entry you 
want.

3 On the Edit menu, click Copy. The selected entries are copied to 
the clipboard in tab-delimited format.

4 Open the document into which you want to copy the information 
and select the Paste command. If the program supports tables or 
is a spreadsheet, you can copy entries into the table or cells by 
selecting them and choosing the Paste command.
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Printing the activity log
You can print the activity log to keep a written record of it. Printing the 
log does not clear the entries. The entries remain in the log until you 
clear it, or until they are overwritten by newer entries.

To print the activity log

1 On the Tools menu in the ABM main window, point to View Log, 
and click your user name or Guest.

2 On the File menu, click Print.
- Or -
Click the Print icon on the toolbar.

3 In the Print dialog box, choose the print options you want and 
click OK.

4 You can keep the activity viewer open while you work in the ABM. 
To close the activity viewer, on the File menu, click Exit.

Clearing the activity log
If you would like, you can clear the activity log using this procedure, 
but it is not necessary. The oldest entries are overwritten as new 
entries are added.

To clear the activity log

1 On the Tools menu in the ABM main window, point to View Log, 
and click your user name or Guest.

2 On the Edit menu, click Clear. 

3 Click OK to confirm clearing the log.

4 You can keep the activity viewer open while you work in the ABM. 
To close the activity viewer, on the File menu, click Exit.
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Refreshing the view of the activity log
If you left the log open while you were working, you might need to 
refresh it to see the most current information.

Do one of the following:

� On the activity log’s Edit menu, click Refresh.

� Close the activity log and reopen it.

Viewing properties

The View Properties dialog box allows you to see the properties of a 
selected file (such as the type of file, location, contents, and owner) or 
see the file itself. You can view the properties of any file, but you can 
only change information in your private address books and the Public 
Fax address book.

To view properties

1 In the ABM main window, click the folder or item whose properties 
you want to see.

2 On the File menu, click Properties.

3 A dialog with the type, location, size, contents, and owner of the 
file appears, or the file opens. View or make any changes to the 
file in the properties dialog box.

4 Click OK, Change, or Cancel (whichever applies) to return to the 
main window.
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Controlling the view of the ABM main window

The View option on the menu bar lets you customize the display of 
your ABM main window. Changing the view of the ABM only affects 
the view at your computer.

� To show or hide the Toolbar: On the View menu, select Toolbar 
to check or uncheck it. When checked, the Toolbar shows at the 
top of the ABM main window.

� To show or hide the Status Bar: On the View menu, select Status 
Bar to check or uncheck it. When checked, the Status Bar shows 
in the ABM main window.

� To refresh the view of the window: On the View menu, click 
Refresh.

Backing up and restoring private address books

The administrator can back up all of the address books but does not 
have to do it. If you would like, you can backup and restore your own 
address books.

Backing up your private address books
Use this procedure to back up your Private Email and Distribution 
Lists address books. 

To back up your private address books

1 Make sure the HP Digital Sender Link is running.

2 Start the ABM.

3 On the Tools menu, click Backup.

4 In the Backup dialog box, select a location in which you want to 
store the backup.

5 In the File name field, type a name for the file.

6 Click Save to begin the backup.
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Restoring your private address books
If you have backed up your private address books, you can use them 
to overwrite the current ones. Also, you can use this feature to move 
backed up copies of your private address books for one digital sender 
to another one.

To restore your private address books

1 Start the ABM. If you are moving copies of the address book for 
one digital sender to another one, make sure to log in to the 
digital sender you are restoring address books to.

2 On the Tools menu, click Restore.

3 In the Look in field, the last selected folder appears. If this is not 
the folder where the backup is stored, select the correct one.

4 Select the backup file.

5 Click Open to begin the restoration.
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Changing to the ABM for another digital sender

You can log out from the ABM for the digital sender you are currently 
using and log in to the ABM for another digital sender. To do this, you 
will need to know the other digital sender’s DNS name or IP address. 

To change digital senders

1 On the Digital Sender menu in the ABM main window, click 
Change.

2 A dialog box similar to the original login screen appears. In the 
Digital Sender name field, type the DNS name or IP address for 
the other digital sender. Or, select it from the list.

3 In the User Password field, type your password (if defined) for 
the ABM for the other digital sender.

4 Click OK to log on to the other digital sender.
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4 Using the HP Digital 
Sender Link

Introduction

The HP Digital Sender Link (Link) is the program on your computer 
that accepts scanned documents and places them in the default inbox 
location. You use the Control Panel applet for the Link to do the 
following:

� Change the path to the default inbox location.

� Determine whether or not to allow documents to be sent to your 
computer.

� Change the target program.

� Determine whether or not the target program automatically starts 
when new data is received to the default inbox location.
EN Introduction 77



Running the HP Digital Sender Link

There are two parts to the HP Digital Sender Link: the Control Panel 
applet and the program itself. Use the applet to configure settings for 
the program. The program itself must be running when you are 
sending to the computer.

To start the Control Panel applet

Open the settings dialog box in one of the ways listed below.

� From Windows Control Panel, double-click the HP Digital Sender 
Link icon.

� Right-click  in the Windows taskbar and choose Settings.

� Double-click .

To start the program

Note The program starts automatically when you turn the computer on, but 
you can also start it manually.

1 Click Start, point to Programs, then HP 9100C, and click HP 
Digital Sender Link.

2 The program’s receive capabilities must also be enabled when 
you want to send to the computer. See “Setting receive 
capabilities” on page 83.
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To close the program

Note The program normally does not need to be closed. If you do not want 
anyone sending to your computer, you might only want to disable 
receive capabilities. See “Setting receive capabilities” on page 83.

Close the program in one of the ways listed below.

� Right-click  in the Windows taskbar and choose Close 
program.

� Press CTRL+ALT+DELETE to open the Windows Close Program 
dialog box. Click HP Digital Sender Link and click End Task.
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Using the taskbar icon

The icon for the Link appears in the Windows taskbar and gives you 
easy access to Link settings and functions, as well as a shortcut for 
opening the ABM.

Showing or hiding the icon
You can determine whether or not the Link icon shows in the 
Windows taskbar. 

To show or hide the icon

1 In the Windows Control Panel, double-click the HP Digital Sender 
Link icon.

2 Click the Settings tab.

3 Do one of the following.

• To show the icon, select the Show icon on taskbar check 
box. The  icon appears on the taskbar.

• To hide the icon, clear the Show icon on taskbar check box.

Note When the icon is showing, you can hide also by right-clicking it and 
choosing Hide icon.
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Accessing taskbar icon options
When you right-click the Link icon in the taskbar, you can access the 
options listed in the table below.

Choose this shortcut 
menu item

To do this

Settings Open the Control Panel applet, where you can 
view and change settings for the HP Digital 
Sender Link. 

HP Address Book 
Manager

Open the HP Address Book Manager program, 
where you can change your user profile, add 
destinations to address books, and more. (See 
chapter 3 for more information.)

Disable Receive 
- Or -
Enable Receive

Disable the HP Digital Sender Link without 
actually closing it, or enable the program if it is 
running but disabled. When disabled, the icon 
has a red X through it, and no one can send to 
your computer.

Hide Icon  Hide the icon. Hiding the icon does not close the 
HP Digital Sender Link. See “To show or hide the 
icon” on page 80 to show the icon again.

Close program Close the HP Digital Sender Link. See “Running 
the HP Digital Sender Link” on page 78 to restart 
it.

About HP Digital Sender 
Link

View copyright information about the program.
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Configuring default inbox settings

The default inbox location is where documents sent to your computer 
are stored before they are routed to the target program. You can 
choose where the default inbox location is and whether or not to allow 
your computer to receive scanned documents.

Choosing the default inbox location
You can choose a different default inbox location from your current 
one using this procedure. The location can be on your computer or 
the network, but you must have privileges to write to that location.

To choose your default inbox location

1 In the Control Panel applet, click the Inbox tab.

2 In the Path to receive inbox field, type the path to the location 
where you want scanned documents to be stored. If the path you 
type does not already exist, it will be created.
- Or -
Click ... to browse folders and find the path to the location.

3 Click OK.
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Setting receive capabilities
The receive capabilities must be enabled if you want to receive 
scanned documents. Disable them when you do not want anyone 
sending documents to your computer.

You can set the receive capabilities using the Control Panel applet or 
the  icon.

To set receive capabilities from the Control Panel 
applet

1 In the Control Panel applet, click the Inbox tab.

2 Select the Enable receive check box to allow your computer to 
receive scanned documents. 
- Or - 
Clear the check box to prevent your computer from receiving 
them.

3 Click OK.

To set receive capabilities from the Link icon
� When the icon looks like this: , the program is running and 

your computer can receive scanned documents. To prevent your 
computer from receiving, right-click the icon and choose Disable 
receive.

� When the icon looks like this: , the program is running but the 
computer cannot receive scanned documents. To allow your 
computer to receive, right-click the icon and choose Enable 
receive.
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Configuring the target program

The target program is the program where documents sent to your 
computer are ultimately received and viewed. You can determine 
which program is the target program and whether or not that program 
starts automatically when data is received. 

Choosing the target program
You can choose any program as the target program, but the program 
must accept data in .pdf or multipage .tif format.

To choose the target program

1 In the Control Panel applet, click the Desktop tab.

2 In the Path to target application field, type the path to the 
program you want to use as the target program. Include the name 
of the program itself as the last item in the path.
- Or -
Click ... to browse and find the path to the program.

3 In the Target application initial path field, type the drive and first 
level folder where the program is located. For example, 
c:\target program.
- Or -
Click ... to browse and find the initial path to the program.

4 Click Advanced. 

5 Make sure the Start With Document File Name check box is 
selected. (This enters %F in the Target Application Parameters 
field.) Using this parameter, a newly scanned document will be 
displayed automatically when the target program opens.

6 Click OK to save the settings.

7 If you chose a default target program that accepts the multipage 
.tif file format instead of .pdf, you must change the file format 
setting. See “Changing an existing user profile” on page 53.
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Setting automatic start capabilities
This setting controls whether or not the target program starts 
automatically when documents are sent to your computer.

If you enable this setting, the target program automatically starts and 
displays a scanned document after the document arrives at the 
default inbox location. If you disable this setting, the scanned 
document remains in the default inbox location as a saved file and is 
displayed in the target program only after you start the program 
yourself.

To set automatic start capabilities

1 In the Control Panel applet, click the Desktop tab.

2 To enable the target program to start automatically, select the 
Automatic execution check box. 
- Or -
To disable the automatic start setting, clear the check box.

3 Click OK. 
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5 Troubleshooting

Introduction

This chapter is your guide for resolving problems that might occur 
while you are using the HP 9100C Digital Sender. The chapter is 
divided into the following sections:

� Sources for information about problems. See page 88.

� Clearing paper jams. See page 89.

� Troubleshooting the digital sender. See page 93.

� Activity log messages. See page 103.

� Troubleshooting the software. The software includes the 
installation, HP Address Book Manager (the ABM) and the HP 
Digital Sender Link. See page 110 to begin.

The digital sender troubleshooting and software troubleshooting 
sections are further divided into two parts, one covering problems that 
did not generate an error message and another one for problems that 
did generate a message. 

Typically, messages appear on the control panel, in the activity log, or 
in the program you are using when there are problems. These 
messages usually require some action before sending can continue. 
In this chapter, you can find recommended actions to resolve 
problems associated with these error messages.
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Sources for information about problems

If you are experiencing a problem with the digital sender, use the 
following sources to obtain more information.

Sources for information about problems

Control panel light A three-color light under the  key on the control panel provides 
information about operation. See “Control panel messages” on page 97 
for a list of messages associated with each condition, and 
recommended actions.
� Off.  The digital sender is in an idle state.

� Flashing green and orange. The digital sender is in the process of 
starting.

� Steady green. The digital sender is ready to send.

� Flashing green. The digital sender is processing a job.
� Steady red. The digital sender cannot complete a job for some 

reason, usually because more information is needed.
� Flashing red. A problem has occurred. 

Control panel 
messages 

Messages on the control panel display when there are problems. See 
“Control panel messages” on page 97 for a list of messages and 
recommended actions.

Activity log The activity log is a record of digital sender use, and is probably your 
best tool for troubleshooting. It contains messages (warning, error, or 
fatal) that can help you resolve problems. See “Activity log messages” 
on page 103 for a list of messages and recommended actions. 

Messages for 
programs

Messages appear in the program you are using when there are 
problems. See “Troubleshooting the software” on page 110 for lists of 
these messages and recommended actions.
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Clearing paper jams

When you have a paper jam, the control 
panel displays this message:  Paper 
jam. Open the cover and remove the 

paper. Use the appropriate procedure 
below to clear the jam.

To clear jams at the start of a 
page

1 Raise the control panel.

2 Remove the jammed paper.

3 Push the control panel down 
securely.

4 The control panel prompts you to do 
one of the following:

� Reinsert the paper and press  
to continue sending.

� Stop processing and send the 
data to its destination by pressing 
SEND.

� Stop sending without saving your 
data by pressing .

1

2

3
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To clear jams inside the ADF

1 Raise the control panel.  

2 Raise the ADF unit.

3 Open the delivery guide by grasping 
the small plastic handles on either 
side of the delivery guide and pulling 
down.

4 Remove the jammed paper.

1

2

3

4
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5 Close the delivery guide sheet by 
aligning its holes with the small 
plastic spindles on the delivery guide 
and pressing down.

6 Close the ADF unit.

7 Push the control panel down 
securely.

8 The control panel prompts you to do 
one of the following:

� Reinsert the paper and press  
to continue sending.

� Stop processing and send the 
data to its destination by pressing 
SEND.

� Stop sending without saving your 
data by pressing .

5

6
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To clear jams at the end of a 
page

1 Raise the control panel and then the 
document tray.  

2 Remove the jammed paper.

3 Close the document tray and push 
the control panel down securely.

4 The control panel prompts you to do 
one of the following:

� Reinsert the paper and press  
to continue sending.

� Stop processing and send the 
data to its destination by pressing 
SEND.

� Stop sending without saving your 
data by pressing .

1

2

3
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Troubleshooting the digital sender

Troubleshooting for the digital sender is divided into two sections, 
General digital sender troubleshooting and Control panel messages. 
General digital sender troubleshooting includes problems that might 
occur that do not generate error messages. 

Note As a general rule for all problems, check both the control panel and 
activity log for relevant messages. You can find an explanation of these 
messages under “Control panel messages” on page 97 and “Activity 
log messages” on page 103. 

General digital sender troubleshooting
Use the table below to solve common problems encountered while 
using the digital sender. The control panel does not display a 
message for these types of problems. If the control panel is displaying 
a message, see “Control panel messages” on page 97.

General digital sender troubleshooting

Problem Actions

Digital sender is not 
working.

� Make sure the power cord is securely connected to the digital 
sender and is plugged into the power outlet.

� Make sure the digital sender is turned on.

� Make sure the digital sender is unlocked. If you try to send a 
document when the digital sender is locked, it will emit a harsh, 
grinding sound.

� See if the digital sender has overheated. The digital sender 
automatically stops working if environmental conditions cause it to 
overheat. If this happens, turn the digital sender off, wait for it to 
cool down, and then turn it back on.

Control panel is not 
working.

� Make sure the power cord is plugged into the power outlet.

� Make sure the control panel cable is securely connected.

� Check the control panel contrast. You can change the contrast if 
needed using SHIFT+ALT+  or SHIFT+ALT+ .

Digital sender does not 
accept your password.

� Verify that you are using the correct password.

� Passwords are case-sensitive. Make sure you enter your password 
with the correct combination of uppercase and lowercase letters.
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Image quality is poor. � If scanned pages are blank, white, or have repeated patterns, 
make sure that a page is not already on the glass.

� Make sure that the document you are trying to send is placed face 
up in the ADF or face down on the glass.

� Make sure the glass is clean. If the glass is dirty, clean it with a dry, 
soft cloth.

� If the problem is with the image quality of jobs sent to a printer, 
check the settings at the printer. 

When using the ADF, 
the digital sender is 
feeding multiple sheets, 
skewing pages, or 
jamming frequently.

� Adjust the guides so that they are snug against the stack but not 
too tight.

� The maximum number of pages the ADF can hold is 50 or fewer, 
depending on the type of media being loaded. 

� The maximum number of pages the output tray can hold is 50 or 
fewer. Make sure more pages are not stacking up in the output tray.

� The type of media being loaded might not meet the required 
specifications.

� If users have been feeding unsupported items through the ADF (for 
example, carbon copy forms), the rollers might have accumulated a 
residue or been damaged. See the administrator guide for the 
replacement procedure.

Your private address 
books are not 
accessible at the 
control panel.

� When sending an e-mail message, you must type your user name 
in the FROM field exactly as it appears in your user profile. You 
cannot type your e-mail address and access your private address 
books.

� Your password must be typed exactly as it appears in your user 
profile. Passwords are case-sensitive, so be sure you enter the 
correct combination of uppercase and lowercase letters.

An item loaded in the 
ADF keeps jamming.

� If you are sending a document that is too large, it might jam in the 
ADF. The largest document you can place in the ADF is 215.9 by 
355.6 mm (8.5 by 14 in). Use the glass to send the document.

� If you are sending a document that is too small, it might jam in the 
ADF. The smallest document you can place in the ADF is 148.5 by 
210 mm (5.9 by 8.3 in). Use the glass to send the document.

Digital sender is 
sending items very 
slowly.

� You might have selected a Quality setting that is making the 
document into a large file that is sending slowly (for example, 
Color-B/W Photo). To speed up the sending process, try choosing 
a different setting (for example, B/W Document).

General digital sender troubleshooting (continued)

Problem Actions
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A document sent to a 
computer did not arrive 
in the default inbox.

� Make sure the destination computer is turned on.

� Make sure the HP Digital Sender Link is running. If it is not, start it 
by clicking Start, pointing to Programs, then HP 9100C, and 
clicking HP Digital Sender Link. 

� Make sure the Enable Receive setting in the HP Digital Sender 
Link is enabled. To check this, click the Receive inbox tab in the 
Control Panel applet and verify that the Enable receive check box 
is selected.

� Using the Control Panel applet of the HP Digital Sender Link, make 
sure a path to the receive inbox has been specified and that the 
path is correct.

� The job might have been lost because of a serious internal 
problem. All pending jobs are sometimes lost when this happens. 
Resend the document.

An e-mail transmission 
you sent did not arrive 
at the destination e-mail 
address.

� If you typed the e-mail address at the control panel, make sure you 
typed it correctly.

� See if you received a “returned mail” message in your e-mail inbox. 
Often, this message explains why the e-mail was not delivered. 

� The job might have been lost because of a serious internal 
problem. All pending jobs are sometimes lost when this happens. 
Resend the e-mail message.

A fax transmission you 
sent did not arrive at 
the destination fax 
machine.

� The receiving fax machine might be turned off or experiencing an 
error condition such as out of paper or toner. Check with the 
recipient.

� The LAN fax server might be busy sending other faxes or waiting to 
redial other faxes. The server might also have reached its 
maximum limit of 128 pending fax transmissions. Wait and retry.

� Using the ABM, check your activity log to see if the fax reached the 
LAN fax server. If a problem is reported in the log, try turning the 
digital sender off and then on again and then resending the fax.

� For information about the transmission, check any fax notifications 
that might have been returned (for example, 
e-mail notifications in your e-mail inbox, or printed transaction 
reports, if these reports are possible with your LAN fax product).

� The job might have been lost because of a serious internal 
problem. All pending jobs are sometimes lost when this happens. 
Resend the fax.

A document sent to a 
printer did not print.

� Make sure the printer is online and working properly.

� Make sure that all cabling is securely connected.
� The job might have been lost because of a serious internal 

problem. All pending jobs are sometimes lost when this happens. 
Resend the document.

General digital sender troubleshooting (continued)

Problem Actions
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E-mail confirmations of 
e-mail transmissions 
are not being received. 

� Your company’s e-mail server might not support DSN (Delivery 
Status Notification), or one of the links to the receiving e-mail 
address does not support DSN.

� In the ABM, verify that the e-mail notification check box is selected 
and that your e-mail address is correct. 

Fax transaction reports 
are not printing at a 
network printer.  

� Make sure the printer is turned on and online.

� Make sure that all cabling is securely connected.

� Your company’s LAN fax product might not support transaction 
reports, or the setting has been disabled by your administrator. 
Note that you can still see fax transmission information in the 
activity log (see “Using the activity log” on page 70). 

The bottom of a page 
that you sent is cut off. 

� If sent from the flatbed, the document page might be too long. The 
maximum length that the flatbed can handle is 279 mm (11 in). The 
ADF can handle pages up to 355.6 mm (14 in) long.

� If sent to a printer, the page might be too complex (require too 
much memory) for the printer to process. If possible, choose a 
printer with more memory.

General digital sender troubleshooting (continued)

Problem Actions
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Control panel messages
This following table lists the messages the control panel might display 
while you are using the digital sender, the cause of the message, and 
recommended actions.

Note The messages are listed in alphabetical order. Messages that report 
normal status are not included.

Control panel messages

Message Description Action

AB Error codes An internal problem in 
accessing address books 
has occurred.

� Turn the digital sender off and then 
back on.

� If the problem persists, note the 
codes and contact the administrator.

Cannot connect to PC. You selected the PC 
function, but the 
destination computer is 
off or the HP Digital 
Sender Link is not running 
on that computer.

� Make sure the destination computer 
is turned on.

� Make sure the HP Digital Sender 
Link is running on the destination 
computer. If it is not, start it by 
clicking Start, pointing to Programs, 
then HP 9100C, and clicking HP 
Digital Sender Link.

� Make sure the Enable Receive 
setting for the HP Digital Sender Link 
is enabled. To check this, click the 
Receive inbox tab in the Control 
Panel applet and verify that the 
Enable receive check box is 
selected.

� Using the Control Panel applet of the 
HP Digital Sender Link, make sure a 
path to the receive inbox has been 
specified and that the path is correct.

Configuration changed. 
Please wait...

The administrator is 
updating the digital 
sender with changes. The 
digital sender is 
unavailable for use while 
the update takes place.

Wait until the message clears.

Device unreachable. You selected the HP 
JetSend function, but the 
destination device is off.

Make sure the destination device is 
turned on.
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Duplicate addressee 
exists. Last recipient not 
added.

Notification message only. 
You selected or entered a 
duplicate e-mail 
destination. The digital 
sender uses only the first 
one you entered.

No action required.

Duplicate fax number 
exists. Last fax recipient 
not added.

Notification message only. 
You selected or entered a 
duplicate fax destination. 
The digital sender uses 
only the first one you 
entered.

No action required.

E-mail server not 
available. Contact the 
administrator.

You selected the e-mail 
function, but the e-mail 
server is turned off or 
cannot be reached.

� Turn the digital sender off and then 
on again.

� Make sure all cabling is securely 
connected.

� If the problem persists, contact the 
administrator.

Errors were found 
checking the address 
book. Please, check the 
log file.

Notification message only. 
An internal check of the 
address book database 
found and removed at 
least one problem entry. 
Check the activity log for 
the number of problem 
entries that were 
removed.

Contact the administrator.

Errors were found when 
checking the address 
book. Initialize address 
book?

An internal check of the 
address book database 
found significant 
problems.

Contact the administrator.

Internal error. codes
Digital Sender halted.

Internal problem. � Turn the digital sender off and then 
back on.

� If the problem persists, note the 
codes and contact the administrator.

Invalid credentials. Check 
account name and 
password.

The name and password 
that have been configured 
for authenticating LDAP  
searches are invalid.

Contact the administrator.

Control panel messages (continued)

Message Description Action
98   Chapter 5 - Troubleshooting EN



Invalid PIN. Job canceled. You sent a document to 
an HP JetSend device 
that requires a PIN 
(personal identification 
number). The digital 
sender does not work with 
devices that require PINs.

Send the document to a device that 
does not require a PIN.

JetDirect not responding. 
Please check the card or 
the firmware version.

The firmware version of 
the HP JetDirect print 
server (interface card) 
installed in the digital 
sender is not compatible 
with the product.

Contact the administrator.

JetSend subsystem busy. The digital sender has 
another HP JetSend job 
pending.

The pending HP JetSend job must 
complete before you can submit 
another one. Wait and retry.

LDAP protocol error.
Search error.

The LDAP search could 
not complete because of 
a problem with a network 
connection or LDAP 
server.

� Turn the digital sender off and then 
back on.

� If the problem persists, contact the 
administrator.

Low resources. There is not enough 
space on the hard drive to 
process the job (for 
example, because too 
many other jobs are 
pending).

Try again later.

Missing page in second 
pass. Job canceled.

You selected the duplex 
mode, but there are fewer 
pages in the second pass 
than in the first.

Press any key to clear the message. 
Check your pages and retry the job.

Network error codes. There is a problem with 
the HP JetDirect print 
server.

� Turn the digital sender off and then 
back on.

� Note the codes and contact the 
administrator.

No destination available. No destination has been 
configured for the 
customized function key 
that you selected.

Contact the administrator.

No matches found. There is no entry in the 
LDAP directory that 
matches your search 
string and search criteria.

Check the accuracy of your search 
string and search criteria.

Control panel messages (continued)

Message Description Action
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No pages scanned.  Job 
canceled.

After a paper-jam error, 
you did not reinsert a 
document in the ADF.

Press any key to clear the message. 
Place the document in the ADF and try 
again.

Object not found. Check 
your configuration.

Either the search root or 
the name/password 
combination for 
authenticating searches in 
the LDAP server is 
incorrect.

Contact the administrator.

Paper feeder not 
connected. Check the 
paper feeder cable.

The ADF unit is not 
securely connected to the 
digital sender.

Make sure the cable that attaches the 
ADF unit to the digital sender is 
connected securely.

Partial results. Check your 
configuration.

The search root for 
searches in the LDAP 
server is incorrect.

Contact the administrator.

Search error. An unexpected problem 
occurred in the LDAP 
search.

� Try the search again.

� Turn the digital sender off and then 
on again. Then, try the search again.

� If the problem persists, contact the 
administrator.

Sorry, you have typed an 
incorrect password. 
Please retype your 
password.

The digital sender did not 
recognize the password 
you typed.

� Press any key to clear the message, 
and then retype the password. 
Passwords are case-sensitive, so 
make sure you enter the correct 
combination of lowercase and 
uppercase letters.

� If the problem persists, contact the 
administrator.

The DNS configuration is 
inconsistent. Please 
check.

There is a problem with 
the DNS (Domain Name 
System) configuration.

� Turn the digital sender off and then 
back on. 

� If the problem persists, contact the 
administrator.

The e-mail configuration 
is inconsistent. Please 
check.

There is a problem with 
the e-mail configuration.

� Turn the digital sender off and then 
back on.

� If the problem persists, contact the 
administrator.

The LDAP configuration is 
inconsistent. Please 
check.

There is a problem with 
the LDAP configuration.

� Turn the digital sender off and then 
back on.

� If the problem persists, contact the 
administrator.

Control panel messages (continued)

Message Description Action
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The LDAP server is 
currently unreachable. 
Contact the administrator.

There is a problem with 
either the LDAP server or 
the network.

� Try again later.

� If the problem persists, contact the 
administrator.

The PC address in your 
user profile is invalid. 
Contact the administrator.

The IP address for your 
computer in your user 
profile is invalid.

� Using ABM, go to your user profile 
and click Restore Defaults. This 
restores the IP address that has 
been assigned to your computer, if it 
has somehow been changed. Note 
that this restores all other defaults for 
your profile as well, so verify that all 
values are correct. 

� If the problem persists, contact the 
administrator.

The search took too much 
time. Search cancelled.

The LDAP search timed 
out.

� Narrow the scope of your search, 
either by entering a longer search 
string or using different search 
criteria.

� If the problem persists, contact the 
administrator.

The user name you typed 
was not found. Contact 
the administrator.

The digital sender did not 
recognize the user name 
you entered.

� Try again.
� If the problem persists, contact the 

administrator.

The WINS configuration is 
inconsistent. Please 
check.

There is a problem with 
the WINS (Windows 
Internet Naming Service) 
configuration.

Contact the administrator.

This operation can require 
several minutes. Do you 
really want to proceed?

You are being asked to 
confirm that you want to 
check the address book 
database.

Contact the administrator.

This will clear the 
configuration and all the 
destinations. Do you 
really want to proceed?

You are being asked to 
confirm that you want to 
reset the digital sender to 
the factory defaults.

Contact the administrator.

This will clear your 
changes. Do you really 
want to proceed?

You are being asked to 
confirm that you want to 
discard all changes made 
in the configuration menu.

Contact the administrator.

Control panel messages (continued)

Message Description Action
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Too many e-mail 
recipients. Last e-mail 
recipient deleted.

You can send an e-mail 
message to a maximum 
of 1,024 e-mail addresses 
(including all those in 
distribution lists). 

Press OK to clear the message and 
continue with the transmission. Send 
the same message again to all the 
recipients who were not included in the 
first transmission.

Too many fax recipients. 
Last fax recipient deleted.

You can send a fax to a 
maximum of 64 
destinations.

Press OK to clear the message and 
continue with the transmission. Send 
the same fax again to all the recipients 
who were not included in the first 
transmission.

Too many matches. If the 
recipient was not found, 
press CANCEL and refine 
your query.
Partial results. 
number items found.

The number of entries 
that matches the criteria 
in your LDAP search is 
greater than the maximum 
number of results that the 
digital sender has been 
configured to return.

� Narrow the scope of your search, 
either by entering a more specific 
search string or using different 
search criteria.

� If the problem persists, contact the 
administrator.

Too many pending faxes. 
Please, delete a fax 
destination.

The digital sender can 
hold up to 128 pending 
fax transmissions.

Wait until the number of pending faxes 
decreases and resend the fax.

Unexpected pages in 
second pass. Job 
canceled.

You selected duplex mode 
and there are more pages 
in the second pass than in 
the first.

Press any key to clear the message. 
Check your pages and retry the job.

You do not have sufficient 
access rights.

The account name used 
to authenticate searches 
with LDAP server has 
insufficient rights to 
access the information.

Contact the administrator.

Your profile is not 
enabled. Contact the 
administrator.

The administrator needs 
to validate new user 
profiles and any changes 
made to user profiles.

Contact the administrator.

Control panel messages (continued)

Message Description Action
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Activity log messages

The activity log for each user contains up to 100 messages. The 
activity log for the administrator contains up to 200 messages. When 
the maximum number of messages has been reached, new 
messages begin overwriting the oldest messages.

The icons shown below appear in the activity log to identify the type of 
message:

See “Using the activity log” on page 70 for information on how to view, 
save, copy, clear, and print the activity log.

normal
Normal activity; no action required.

warning
The function completed partially; no action is required. For 
example, you sent an e-mail message but one recipient 
could not be reached.

error
The function failed; requires some action, either by the user 
or the administrator. Generally, the digital sender can still be 
used for other functions.

fatal
A severe problem; requires administrator intervention and 
possibly a call to HP customer support.
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Activity log messages

Message Description Action

001/01
E-mail send report. Sender: 
name. Subject: subject. 
Status: Failed.

The e-mail transmission was 
unsuccessful. You might have 
entered an incorrect e-mail 
address.

� Try the transmission again.

� Make sure all cabling is 
connected securely.

� In the ABM, make sure that 
Delivery Notification is 
enabled for your user 
profile.

� If the problem persists, 
contact the administrator.

001/02
E-mail send report. Sender:  
name. Subject:  subject. 
Status: OK.

Notification message only. 
Your e-mail transmission was 
successful.

No action required.

001/03
E-mail send report. Sender: 
name. Subject: subject. 
Status: Image processing 
error.

The e-mail transmission was 
unsuccessful. An internal error 
occurred while the document 
was being processed.

� Try the transmission again.
� Turn the digital sender off 

and then back on.
� If the problem persists, 

contact the administrator.

002/01
Document sent to a PC. PC: 
identification. Result: failed.

The digital sender could not 
deliver the document to the 
named computer.

� Make sure the receiving 
computer is on.

� Make sure the HP Digital 
Sender Link is running and 
enabled on the receiving 
computer.

� Make sure the IP address or 
DNS name of the receiving 
computer is correctly typed.

� If the problem persists, 
contact the administrator.

002/02
Document sent to a PC. PC: 
identification. Result:  success.

Notification message only. The 
document was successfully 
delivered.

No action required.

002/03
Document sent to a PC. PC: 
identification. Result: Image 
processing error.

An internal error occurred 
while the document was being 
processed.

� Try sending again.
� Turn the digital sender off 

and then back on.
� If the problem persists, 

contact the administrator.
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003/01
Document sent to the 
HP Digital Sender Service. 
Recipient(s): name. Number: 
fax number. # of pages: pages. 
Result: Failed. Local disk 
access failure. Code: code.

The document could not be 
delivered to the HP Digital 
Sender Service.

� Turn the digital sender off 
and then back on.

� If the problem persists, note 
the code and contact the 
administrator.

003/02
Document sent to the 
HP Digital Sender Service. 
Recipient(s): name. Number: 
fax number. # of pages: pages. 
Result: Failed. Login fax 
daemon failure. Code: code.

There is a problem sending 
the document to the HP Digital 
Sender Service.

Note the code and contact the 
administrator. 

003/03
Document sent to the 
HP Digital Sender Service. 
Recipient(s): name. Number: 
fax number. # of pages: pages. 
Result: Failed. Open remote 
file failure. Code: code.

There is a problem sending 
the document to the HP Digital 
Sender Service.

Note the code and contact the 
administrator.

003/04
Document sent to the 
HP Digital Sender Service. 
Recipient(s): name. Number: 
fax number. # of pages: pages. 
Result: Failed. Write to remote 
file failure. Code: code.

There is a problem sending 
the document to the HP Digital 
Sender Service.

Note the code and contact the 
administrator.

003/05
Document sent to the 
HP Digital Sender Service. 
Recipient(s): name. Number: 
fax number. # of pages: pages. 
Result: Failed. Close remote 
file failure. Code: code.

There is a problem sending 
the document to the HP Digital 
Sender Service.

Note the code and contact the 
administrator.

003/06
Document sent to the 
HP Digital Sender Service. 
Recipient(s): name. Number: 
fax number. # of pages: pages. 
Result: Failed. Get fax 
workarea failure. Code: code.

There is a problem sending 
the document to the HP Digital 
Sender Service.

Note the code and contact the 
administrator.

Activity log messages (continued)

Message Description Action
EN Activity log messages 105



003/07
Document sent to the 
HP Digital Sender Service. 
Recipient(s): name. Number: 
fax number. # of pages: pages. 
Result: Failed. Missing fax 
workarea. Code: code.

There is a problem sending 
the document to the HP Digital 
Sender Service.

Note the code and contact the 
administrator.

003/08
Document sent to the 
HP Digital Sender Service. 
Recipient(s): name. Number: 
fax number. # of pages: pages. 
Result: Failed. Out of memory. 
Code: code.

There is a problem sending 
the document to the HP Digital 
Sender Service.

� Turn the digital sender off 
and then back on.

� If the problem persists, note 
the code and contact the 
administrator.

003/09
Document sent to the 
HP Digital Sender Service. 
Recipient(s): name. Number: 
fax number. # of pages: pages. 
Result: Failed. Fax driver 
configuration failure. Code: 
code.

There is a problem sending 
the document to the HP Digital 
Sender Service.

� Turn the digital sender off 
and then back on.

� If the problem persists, note 
the code and contact the 
administrator.

003/10
Document sent to the 
HP Digital Sender Service. 
Recipient(s): name. Number: 
fax number. # of pages: pages. 
Result: Failed. Biscom submit 
API failure. Code: code.

For networks with the Biscom 
LAN fax product only. There is 
a problem sending the 
document to the HP Digital 
Sender Service.

� Turn the digital sender off 
and then back on.

� If the problem persists, note 
the code and contact the 
administrator.

003/11
Document sent to the 
HP Digital Sender Service. 
Recipient(s): name. Number: 
fax number. # of pages: pages. 
Result: Failed. MIB read 
failure. Code: code.

There is a problem sending 
the document to the HP Digital 
Sender Service.

� Turn the digital sender off 
and then back on.

� If the problem persists, note 
the code and contact the 
administrator.

003/12
Document sent to the 
HP Digital Sender Service. 
Recipient(s): name. Number: 
fax number. # of pages: pages. 
Result: Failed. Invalid job 
descriptor. Code: code.

There is a problem sending 
the document to the HP Digital 
Sender Service.

� Turn the digital sender off 
and then back on.

� If the problem persists, note 
the code and contact the 
administrator.

Activity log messages (continued)

Message Description Action
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003/13
Document sent to the 
HP Digital Sender Service. 
Recipient(s): name. Number: 
fax number. # of receipt: 
number. # of pages: pages. 
Result: Failed. Image 
processing error. Code: code.

An internal error occurred 
while the document was being 
processed.

� Try sending the document 
again.

� Turn the digital sender off 
and then back on.

� If the problem persists, note 
the code and contact the 
administrator.

003/14
Document sent to the 
HP Digital Sender Service. 
Recipient(s): name. Number: 
fax number. # of pages: pages. 
Result: OK. Code: code.

Notification message only. The 
document was successfully 
delivered to the HP Digital 
Sender Service.

No action required.

004/01
Fax transmission result. 
Receipt: name. Number: fax 
number. Accounting: code. # 
of pages: pages. Result: 
successful transmission.

Notification message only. The 
document was successfully 
faxed.

No action required.

004/02
Fax transmission result. 
Receipt: name. Number: fax 
number. Accounting: code. # 
of pages: pages. Result: 
unsuccessful transmission.

The document could not be 
faxed.

� Check the accuracy of the 
fax number and retry.

� If the problem persists, 
contact the administrator.

004/03
Fax transmission result. 
Receipt: name. Number: fax 
number. Accounting: code. # 
of pages: pages. Result: 
missed notification.

Either the fax transmission has 
not yet been sent (it is still 
pending), or the fax server has 
not returned notification within 
24 hours.

Ask the administrator to check 
the status in the fax server 
queue.

005/01
Document sent to an 
application. Menu: name. 
Application: name. Result: 
failed.

The document could not be 
delivered to the program on 
the receiving computer.

� Make sure the receiving 
computer is on.

� Make sure the HP Digital 
Sender Link is running and 
enabled on the receiving 
computer.

� If the problem persists, 
contact the administrator.

Activity log messages (continued)

Message Description Action
EN Activity log messages 107



005/02
Document sent to an 
application. Menu: name. 
Application: name. Result: 
success.

Notification message only. The 
document was delivered 
successfully.

No action required.

005/03
Document sent to an 
application. Menu: name. 
Application: name. Result: 
Image processing error.

An internal error occurred 
while the document was being 
processed.

� Try sending the document 
again.

� Turn the digital sender off 
and then back on.

� If the problem persists, note 
the menu and application 
and contact the 
administrator.

037/00
E-mail not delivered to 
destination name.

The e-mail message could not 
be delivered to the named 
destination. The message was 
successfully delivered to at 
least one of the destinations in 
the message. There will be a 
similar message in the log for 
each destination that could not 
be reached.

� Check the accuracy of the 
e-mail address.

� If the problem persists, 
contact the administrator.

046/00
The SMTP server didn’t 
accept the e-mail message 
because it was too big.

The e-mail server could not 
accept the e-mail message 
transmitted by the digital 
sender because it was too big. 

Contact the administrator.

047/01
Print job result. From: name. 
To: printer name. Result: 
failed.

The printer could not print the 
document sent from the digital 
sender. This might happen if 
you send a job while the 
printer is busy.

� Make sure the printer is on 
and in an idle state.

� Make sure that all cabling is 
securely connected.

� If the problem persists, 
contact the administrator.

047/02
Print job result. From: name. 
To: printer name. Result: 
success.

The print job sent from the 
digital sender printed 
successfully.

No action required.

047/03
Print job result. From: name. 
To: printer name. Result: 
Image processing error.

An internal error occurred 
while the document was being 
processed.

� Try resending the 
document.

� Turn the digital sender off 
and then back on.

� If the problem persists, 
contact the administrator.

Activity log messages (continued)

Message Description Action
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061/00
JetSend job failure. Device 
name: IP address. Device 
unreachable.

The IP address or DNS name 
you typed is incorrect, the 
device is not an HP JetSend 
device, or the device is not 
turned on and in an online 
status.

� If you typed the IP address 
or DNS name, make sure 
the target device is an 
HP JetSend device and that 
you typed the information 
correctly.

� Make sure the target device 
is turned on and in an online 
status.

061/01
JetSend job failure. Device 
name: IP address. Device not 
ready.

The target HP JetSend device 
cannot process the document 
for some reason, depending 
on the type of device. For 
example, a printer might be 
out of paper or one of the 
printer trays might be open.

Check the target device.

061/02
JetSend job failure. Device 
name: IP address. Invalid PIN.

The target HP JetSend device 
requires a PIN (personal 
identification number). The 
digital sender does not work 
with devices that require PINs.

Send the document to a 
device that does not require a 
PIN.

062/00
JetSend device contacted. 
Device name: IP address

Notification message only. 
A connection to the 
HP JetSend device identified 
in the message has been 
made.

No action required.

065/00
JetSend job end.

Notification message only.
The document was 
successfully delivered to the 
HP JetSend destination 
identified in the message.

No action required.

Activity log messages (continued)

Message Description Action
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Troubleshooting the software

The troubleshooting for software is divided into four sections:

� General software troubleshooting (this page)

� Installation messages (page 113)

� HP Address Book Manager messages (page 114)

� HP Digital Sender Link messages (page 118)

General software troubleshooting
Use the table below to solve common problems encountered while 
using the software. The programs do not display messages for these 
types of problems.

Installation problems

Problem Actions

The software did not 
install on Windows 9x.

All programs except Explorer and Systray should be closed before 
installing software. Press CTRL+ALT+DELETE. If there are other open 
programs, click one and click End Task. Repeat for each other open 
program. Then, reinstall the software.

The computer cannot 
read the installation 
compact disc.

� The correct drive might not have been specified. Check for the 
proper drive letter. Often, it is D or E for the CD-ROM drive.

� Check the compact disc for damage. Try using the compact disc on 
another computer, or copy the compact disc folders to the hard 
drive. Then, install from the hard drive.
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Usage problems

Problem Actions

The the ABM or HP 
Digital Sender Link is 
running very slowly. 

� There might be too many programs running on the computer. Try 
closing open programs that you are not using. Also, try restarting 
the computer.

� There might not be enough free space on your computer’s hard 
drive. Free up space on your computer by removing unneeded 
files.

� Data on your computer’s hard drive might be fragmented. Run Disk 
Defragmenter. Click Start, point to Programs, Accessories, 
System Tools, and then click Disk Defragmenter. For more 
information, see the Windows documentation.

You are not receiving 
e-mail confirmation of 
fax transmissions.

� The name you typed at the control panel does not match your user 
name, or your e-mail address is not correct in your user profile in 
the ABM. At the control panel, type your user name exactly as it 
appears in your user profile. Start the ABM. In the main window, 
see how your name is listed. Click the address book for your user 
name. On the File menu, click Properties. Check that your e-mail 
address is correctly entered in the Address field.

� Your company’s LAN fax program might not be configured correctly 
or might not support notification. Contact the administrator.

� The fax transmission might still be pending or the digital sender 
has simply not received notification back from the LAN fax server. 
Check your activity log for status information, or have the 
administrator check on pending faxes.

You are not receiving 
e-mail confirmation of 
e-mail transmissions.

� In your user profile in the ABM, the e-mail notification check box is 
not selected or your e-mail address is not entered correctly. In the 
ABM main window, click the address book for your user name. On 
the File menu, click Properties. Select the Delivery Notification 
check box. Also, make sure that your e-mail address is properly 
entered in the Address field.

� Your company’s e-mail server might not support notification, or one 
of the links to the receiving e-mail address might not support 
notification. Contact the administrator.

The icon for the HP 
Digital Sender Link is 
not on the Windows 
taskbar.

� The setting to show the icon is not selected. In Windows Control 
Panel, double-click the HP Digital Sender Link icon. Click the 
Setting tab. Make sure the Show icon on taskbar check box is 
selected. 

� If the HP Digital Sender Link is closed, the icon does not show. To 
start the program or check if it is running, click Start, point to 
Programs, then HP 9100C, and click HP Digital Sender Link.

The HP Digital Sender 
Link will not start.

There is a problem with the version of the HP Digital Sender Link that 
is installed on the computer. Install the HP Digital Sender Link again.
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Scanned documents 
are not arriving in the 
default inbox location.

� The computer must be on and the HP Digital Sender Link must be 
running and enabled while you are using the digital sender. Make 
sure the destination computer is on. Make sure the HP Digital 
Sender Link is running. If it is not, start it by clicking Start, pointing 
to Programs, then HP 9100C, and clicking HP Digital Sender 
Link. 

� The Enable Receive setting in the HP Digital Sender Link must be 
selected. Click the Receive Inbox tab in the Control Panel applet. 
Make sure the Enable receive check box is selected.

� The path to your default inbox is incorrect. In the HP Digital Sender 
Link, make sure a path to the inbox has been specified and that the 
path is correct.

Usage problems (continued)

Problem Actions
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Installation message
This installation message may appear while you are installing 
software.

Message Description Actions

“This machine has been 
configured by your network 
administrator as a digital 
sender server. The Link 
application cannot work if 
this service is running. To be 
able to receive scanned 
documents directly on this 
PC, the administrator must 
disable the digital sender 
server. Do you want to 
continue?”

The computer on which you 
are trying to install the 
software has the HP Digital 
Sender Service or the upgrade 
for the HP Network ScanJet 5 
scanner installed already.

Contact the administrator before 
proceeding.
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HP Address Book Manager messages
This table contains the error messages that might appear when you 
are using the ABM and actions to take to resolve the problem.

Note Messages are listed in alphabetical order.

HP Address Book Manager messages

 Message Description Actions

ABM has found a number of 
items greater than the 
maximum supported. 
Application may become 
unstable.

The maximum number of 
items that the ABM can 
support has been exceeded 
(for example, maximum 
number of fax destinations or 
e-mail addresses).

Contact the administrator.

ABM internal error code. The ABM has experienced an 
internal error.

� Turn the digital sender off 
and then back on.

� If the problem persists, note 
the code and contact the 
administrator.

Address Book locked. Someone else is using the 
address book you are trying to 
access.

Try accessing the address 
book again.

Cannot access the Windows 
Registry. The Windows 
Registry data is corrupted.

Information in the Windows 
registry has changed for some 
reason and is no longer valid 
for the digital sender.

� Remove LDAP 
configuration data from the 
registry using Regedit.exe 
and then configure the  
LDAP directory service 
again.

� If the problem persists, 
contact the administrator.

Digital sender busy executing 
Address Book backup or 
restore.

Address books in the digital 
sender are either being 
backed up or restored. The 
digital sender is locked from 
use until the backup or restore 
is complete.

Try again later.
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Duplicated login. You might already have 
started the ABM.

A previous connection with the 
ABM might have been 
interrupted.

Another user has logged in 
under the name you used.

Verify that you have not 
already started the ABM.

Unused connections time out 
after a period of time. Wait a 
few minutes and try again.

To prevent another user from 
using your user name in the 
future, protect your user profile 
with a password.

Failed to add the entry. During the procedure to import 
e-mail addresses, the found 
addresses could not be added 
to the ABM because the 
selected address book is full.

Remove some entries from the 
selected address book to 
make room for new entries.

Initialization failed. During the procedure to import 
e-mail addresses, the ABM 
could not connect to the 
server.

In the directory configuration, 
ensure you typed the correct 
DNS name or IP address and 
port number for the server you 
want. See “To define 
directories” on page 58.

In order to proceed, you have 
to provide information for all 
fields.

During the procedure to import 
e-mail addresses, some of the 
fields in the directory 
configuration were not filled.

In the directory configuration, 
make sure all fields are filled. 
See “To define directories” on 
page 58.

Invalid user name or 
password.

The digital sender did not 
recognize the user name or 
password that you typed.

Verify that you are using the 
user name and password that 
are in your user profile. The 
password is case-sensitive, so 
make sure you enter the 
correct combination of 
uppercase and lowercase 
letters. 

Login Failed. Wrong Login 
Name or Password
Bind Failed.

During the procedure, you 
entered an invalid login name 
or password for the server to 
be searched. 

In the directory configuration, 
check the login name and 
password fields for the server 
you are searching. See “To 
define directories” on page 58.

HP Address Book Manager messages (continued)

 Message Description Actions
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Network access failure. There is a problem connecting 
to the digital sender through 
the network.

� Close the ABM and then 
start it again.

� Turn the computer off and 
then back on.

� Turn the digital sender off 
and then back on.

� If the problem persists, 
contact the administrator.

No items have been selected. During the procedure to import 
e-mail addresses, you did not 
select an address before 
clicking Add.

Select an address and then 
click Add.

No matching entries were 
found.

During the procedure to import 
e-mail addresses, no entries 
matching the search criteria 
were found in the specified 
directory.

� In the Directory search 
dialog box, make sure the 
correct directory is specified 
and all fields are filled 
correctly. 

� Make sure the directory you 
are searching has been 
defined. See “To define 
directories” on page 58.

Search failed! 
No such object.

During the procedure to import 
e-mail addresses, the 
directory configuration might 
not be correctly specified.

In the directory configuration, 
make sure all fields are filled 
correctly. See “To define 
directories” on page 58.

The password and the 
confirmation text does not 
match. Please enter them 
again.

During the procedure to import 
e-mail addresses, the 
password for the server that 
was specified in the Password 
and Confirmation fields did 
not match.

In the directory configuration, 
retype the password in both 
fields. See “To define 
directories” on page 58.

The port number you have 
entered is wrong. Please type 
in a different value.

During the procedure to import 
e-mail addresses, you entered 
an incorrect port number for 
the server containing the 
directory to be searched.

� In the directory 
configuration, check the 
port number. See “To define 
directories” on page 58.

� If the problem persists, 
check the port number with 
the administrator.

HP Address Book Manager messages (continued)

 Message Description Actions
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Timeout expired. The digital sender is not 
responding.

� Make sure the digital sender 
is turned on.

� Make sure all cabling is 
securely connected. 

� Turn the digital sender off 
and back on.

� Turn the computer off and 
back on.

� If the problem persists, 
contact the administrator.

You enter a wrong maximum 
of hits number.

During the procedure to import 
e-mail addresses, the number 
of maximum hits (results) you 
entered is more than the 
search can return. 

Enter a smaller number.

Your query has exceeded the 
size limit.

During the procedure to import 
e-mail addresses, the search 
found a greater number of 
entries that match the search 
criteria than allowed by the 
server.

In the Directory search dialog 
box, narrow the Name and/or 
Email address search criteria 
to return fewer entries. (For 
example, search for 
“Smithson” instead of “Smith.”) 
See “To search a directory and 
import addresses” on page 60.

HP Address Book Manager messages (continued)

 Message Description Actions
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HP Digital Sender Link messages
This table contains the error messages that might appear when you 
are using the HP Digital Sender Link and actions to take to resolve 
the problem.

Note Messages are listed in alphabetical order.

HP Digital Sender Link messages

Message Description Actions

A file already exists with the 
same name.

The path specified in the 
Target Application or the 
Default Inbox field already 
exists.

Specify a different path. Or, 
use Windows Explorer to 
delete the existing file.

Address Book Manager still 
active.

The Address Book Manager 
program is already running.

Use the copy of the Address 
Book Manager that is already 
running.

Cannot launch the target 
application.

The program selected as the 
target program cannot be 
found.

Open the HP Digital Sender 
Link and click the Desktop 
tab. Enter the correct path to 
the target program in the Path 
to target application: field, or 
click ... to browse the folders 
and find the correct path. 

Closing this application may 
cause the loss of connection 
with the sender. Close 
anyway?

The message appears when 
you close the HP Digital 
Sender Link. It is only a 
reminder that documents 
cannot be sent to your 
computer while the program is 
closed.

Click Yes to close the program 
or click No to keep the 
program open. If you close the 
program, you can restart it by 
clicking Start, pointing to 
Programs, then 9100C, and 
clicking HP Digital Sender 
Link. 

Error: verify Address Book 
Manager installation.

The Address Book Manager 
program cannot be found.

Uninstall the ABM and then 
reinstall it. 
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Error: verify if another instance 
if the same application is 
already running.

If the message is received on 
a computer running Windows 
9x, the program is already 
running.

If the message is received on 
a computer running Windows 
NT 4.0 or 5.0, the program is 
already running or the HP 
Digital Sender Service is 
running. (The service cannot 
be running at the same time 
as the program.)

No action is needed. You can 
begin sending to the computer. 
To work with the HP Digital 
Sender Link settings, open the 
Control Panel applet from the 
HP Digital Sender Link icon or 
the Windows Control Panel.

Check if the HP Digital Sender 
Service is running or close it 
by double-clicking the 
Services icon in Windows 
Control Panel. Select HP 
Digital Sender Service (or 
HP Network Scanner 
Service) and click Stop. Then, 
try re-opening the program. If 
you still receive the message, 
the program is already 
running, and no other action is 
needed. 

Error writing data into the 
receive inbox.

The document you sent to a 
computer could not be stored 
in the default inbox because 
you do not have the rights to 
write to that location. This can 
happen after installation if 
someone changed the rights 
on the computer where your 
default inbox is located.

The document you send to a 
computer could not be stored 
in the default inbox because 
the hard drive on the computer 
is full.

On the computer where your 
default inbox is located, check 
and change the rights back to 
their previous settings. Or, 
choose a new default inbox 
location. 

If the computer’s hard drive is 
full, free up space and resend 
the document.

HP Digital Sender Link 
parameters not set. Run setup 
utility?

The HP Digital Sender Link is 
either not installed or is not 
configured correctly.

Click Yes to configure its 
parameters correctly.

Not enough rights for the 
specified directory.

The HP Digital Sender Link 
cannot accept or create the 
path specified in the Path to 
Receive Inbox field because 
you do not have enough rights 
to read and write to the 
requested location.

Try retyping the path or 
choose another one. Or, 
change the rights for the 
requested location so you can 
use it.

HP Digital Sender Link messages (continued)

Message Description Actions
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Start in path doesn’t exist. 
Create now?

The path specified in the 
Target application initial 
path field does not exist. Allow 
the program to create the new 
path or choose another path. 

Click Yes to create the new 
path with the name you typed. 
Or, click No and then click ... to 
search for the path you want.

The directory cannot be 
created because there is a 
name conflict with an existing 
file.

The HP Digital Sender Link 
cannot create the specified 
path for the inbox because one 
of the folder names you typed 
is the name of an existing file. 
For example, you typed 
c:\Temp\Scan\Inbox, but there 
is a file in the Temp folder 
called Scan.

Choose another folder or 
specify a new path in that 
folder.

Unable to create the specified 
directory.

The path typed in the Path to 
Receive Inbox field was 
invalid.

You do not have enough rights 
to create the default inbox 
folder in the requested 
location.

Try retyping the path or 
choose another one.

Choose a path to a new 
location where you have 
rights. Or, change the rights 
for the requested location so 
you can use it. 

Unable to find target 
application.

The path in the Path to target 
application field does not 
contain the specified program.

Check the path and try 
retyping it. Include the entire 
path, entering the program 
itself as the last item in the 
path. Or, click ... to search for 
the path to the program you 
want to use.

HP Digital Sender Link messages (continued)

Message Description Actions
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A Specifications

Equipment specifications

Feature Description

Product type � Flatbed and sheetfed

Scanning element � Charged-coupled device

Light source � Xenon lamp

Interface  � LAN:  Ethernet or Token Ring

Optical resolution  � 600 dpi (dots per inch)

Maximum scanning speed � 15 pages per minute (text quality)

Image processing � Black-and-white documents
� Fine text (intended for OCR)

� Color documents

� Color and black-and-white documents
� High-resolution color and black-and-white 

photographs

Compression � Hardware: optimized JPEG

� Software: G4 and HP Smart Compression 
Imaging Technology

AC line voltage � 100 to 240 Vac, 50 to 60 Hz

Power consumption � 33 W idle
� 70 W operating

Noise levels � 35 dB idle
� 50 dB when operating the flatbed

� 55 dB when operating the ADF

Weight � 16.0 kg (35.27 lb)

Duty cycle � 10,000 pages per month
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Control panel display � 240-by-64 pixels graphic LCD

� Blue dots on silver-gray background

� CCFL (Cold Cathode Fluorescent Lamp) 
backlit

Keypad � 40-key alphabetic keypad
� 12-key numeric keypad

� Help key

� Simplex/duplex key for single-sided or 
double-sided scanning

� Green “go” button and red “stop” button
� 4 context-sensitive function keys

Scan engine � Full-color and grayscale ADF (automatic 
document feeder) and flatbed scans

� Image calibration
� Color and tonal adjustment

� Data scaling and enhancement

� Data conversion to different data types 
(text, halftone, and color draft modes)

Automatic document feeder 
(ADF)

� 50-page capacity

� High feeding accuracy and reliability

� High-speed scans
� Variety of paper sizes and weights

� Correct order output

� Automatic start and stop at any speed

Feature Description
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Environmental ranges

CAUTION The operating environment should be stable, with no abrupt changes 
in temperature or humidity, or your digital sender might be damaged. 
If you move the digital sender from a cold to a warm environment, wait 
about two hours before using it.

Temperature

Operating 5 to 40° C (41 to 104° F) 

Storage -30 to 60° C (-22 to 140° F)

Humidity

Operating 10 to 80% noncondensing (10 to 32.5° C)

10 to 45% noncondensing (32.5 to 40° C)

Storage 10 to 85% (0 to 40° C)

10 to 50% (40 to 60° C)
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Supported capabilities 

Operating capabilities

Description Maximum

Multiple selections at control panel (combination of each 
individual e-mail address and each distribution list)

128

Destinations for an e-mail message (combination of all 
individual e-mail addresses and all addresses in 
selected distribution lists)

1,024

Destinations for a fax transmission 64

Pending fax transmissions 128

Characters in a telephone number 80

Memory capabilities

Description Maximum

Users 512

Public e-mail addresses 200,000

Public fax addresses 1,024

Public e-mail distribution lists 512

Public printers 256

Private e-mail addresses for each user 256

Private distribution lists for each user 100

Maximum number of destinations in a distribution list 512

Entries in the activity log for each user 100

Entries in the activity log for the administrator 200

Function keys that can be customized (5 function 
keys already customized)

11

Destinations that can be configured for each customized 
function key

512
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German noise declaration

Geräuschemission

LpA <70 dB
Am Arbeitsplatz
normaler Betrieb
nach EN 27779
Die Daten sind die Ergebnisse von Typprüfungen.

French EMC regulation

NOTE: Réglementation Française - Déclaration d'installation et 
d'utilisation d'un produit ATI de Classe A.

L'utilisateur d'un appareil de traitement de l'information (ATI) de 
Classe A suivant la norme de compatibilité électroma- gnétique 
NFEN 55022, doit être déclaré auprès de la préfecture du 
département ou l'appareil est installé et utilisé ainsi qu'au Ministère 
des Telecommunications.

Le formulaire de déclaration a utiliser est disponible auprès des 
services de la Préfecture.
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Declaration of Conformity

EC Declaration of Conformity
According to ISO/IEC Guide 22 and EN 45014

Manufacturer’s Name: Hewlett-Packard Italiana S.p.A.

Manufacturer’s Address: Viale Europa, 2
24040 Stezzano (BG)
ITALY

Declares that the product

Product Name: HP 9100C Digital Sender
Model Numbers: C1313A, C1314A, C1315A, C1316A
Product Options: All

Conforms to the following specifications:

SAFETY IEC 950:1991 +A1+A2+A3+A4 / EN 60950:1992 +A1+A2+A3+A4
IEC 825-1:1993 / EN 60825-1:1994 Class 1

EMC CISPR 22:1993+A1 / EN 55022:1994 Class A
EN 50082-1:1992

IEC 801-2:1991 / prEN 55024-2:1992 ± 4 KV CD; ± 8 KV AD
IEC 801-3:1984 / prEN 55024-3:1991 3 V/m
IEC 801-4:1988 / prEN 55024-4:1992 ± 0.5 KV signal lines

± 1.0 KV power lines
IEC 1000-4-3:1995 / EN 61000-4-3:1996 3 V/m
IEC 1000-4-5:1995 / EN 61000-4-5:1996 ± 1.0 KV differential

± 2.0 KV common
IEC 1000-3-2:1995 / EN 61000-3-2:1995
IEC 1000-3-3:1994 / EN 61000-3-3:1995

AS/NZS 3548:1992 / CISPR 22:1993 + A1 Class A

Supplementary information:

The product herewith complies with the requirements of the Low Voltage Directive 73/23/EEC and
the EMC Directive 89/336/EEC and carries the CE-marking accordingly.
The product was tested in a typical configuration with Hewlett-Packard test systems.

Bergamo, 30 June 1998

__________________________________
Tiberio Tesi - Quality Assurance Manager

European Contact:  Your local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department 
HQ-TRE, Herrenberger Straße 130, D71034 Böblingen (Fax: +49-7031-3134)
Australian Contact:  Product Regulation Manager, Hewlett-Packard Australia Ltd., 31-41 Joseph Street, Blackburn, Victoria 
3130 - Australia
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Software license agreement

ATTENTION: USE OF THE SOFTWARE IS SUBJECT TO THE HP 
SOFTWARE LICENSE TERMS SET FORTH BELOW. USING THE 
SOFTWARE INDICATES YOUR ACCEPTANCE OF THESE 
LICENSE TERMS. IF YOU DO NOT ACCEPT THESE LICENSE 
TERMS, YOU MAY RETURN THE SOFTWARE FOR A FULL 
REFUND. IF THE SOFTWARE IS BUNDLED WITH ANOTHER 
PRODUCT, YOU MAY RETURN THE ENTIRE UNUSED PRODUCT 
FOR A FULL REFUND. 

HP SOFTWARE LICENSE TERMS

The following License Terms govern your use of the accompanying 
Software unless you have a separate signed agreement with HP.

License Grant. HP grants you a license to use 25 copies of the 
Software. “Use” means storing, loading, installing, executing, or 
displaying the Software. You may not modify the Software or disable 
any licensing or control features of the Software. If the Software is 
licensed for “concurrent use,” you may not allow more than the 
maximum number of authorized users to Use the Software 
concurrently.

Ownership. The Software is owned and copyrighted by HP or its 
third-party suppliers. Your license confers no title to, or ownership in, 
the Software and is not a sale of any rights in the Software. HP's third-
party suppliers may protect their rights in the event of any violation of 
these License Terms.

Copies and Adaptations. You may only make copies or adaptations of 
the Software for archival purposes or when copying or adaptation is 
an essential step in the authorized Use of the Software. You must 
reproduce all copyright notices in the original Software on all copies 
or adaptations. You may not copy the Software onto any public 
network.

No Disassembly or Decryption. You may not disassemble or 
decompile the Software unless HP's prior written consent is obtained. 
In some jurisdictions, HP's consent may not be required for limited 
disassembly or decompilation. Upon request, you will provide HP with 
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reasonably detailed information regarding any disassembly or 
decompilation. You may not decrypt the Software unless decryption is 
a necessary part of the operation of the Software.

Transfer. Your license will automatically terminate upon any transfer of 
the Software. Upon transfer, you must deliver the Software, including 
any copies and related documentation, to the transferee. The 
transferee must accept these License Terms as a condition to the 
transfer. 

Termination. HP may terminate your license upon notice for failure to 
comply with any of these License Terms. Upon termination, you must 
immediately destroy the Software, together with all copies, 
adaptations, and merged portions in any form.

Export Requirements. You may not export or re-export the Software 
or any copy or adaptation in violation of any applicable laws or 
regulations.

U.S. Government Restricted Rights. The Software and any 
accompanying documentation have been developed entirely at 
private expense. They are delivered and licensed as “commercial 
computer software” as defined in DFARS 252.227-7013 (Oct 1988), 
DFARS 252.211-7015 (May 1991), or DFARS 252.227-7014 
(Jun 1995), as a “commercial item” as defined in FAR 2.101(a) 
(Jun 1987), or as “Restricted computer software” as defined in FAR 
52.227-19 (Jun 1987) (or any equivalent agency regulation or 
contract clause), whichever is applicable. You have only those rights 
provided for such Software and any accompanying documentation by 
the applicable DFARs or FAR clause or the HP standard software 
agreement for the product involved. 
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B Warranty and support 
information

Hewlett-Packard limited warranty 
statement

1 HP warrants HP hardware, accessories, and supplies against 
defects in materials and workmanship for the period specified 
above. If HP receives notice of such defects during the warranty 
period, HP will, at its option, either repair or replace products 
which prove to be defective. Replacement parts may be either 
new or like-new.

2 HP warrants that HP software will not fail to execute its 
programming instructions, for the period specified above, due to 
defects in material and workmanship when properly installed and 
used. If HP receives notice of such defects during the warranty 
period, HP will replace software media which does not execute its 
programming instructions due to such defects.

3 HP does not warrant that the operation of HP products will be 
uninterrupted or error free. If HP is unable, within a reasonable 
time, to repair or replace any product to a condition as warranted, 
customer will be entitled to a refund of the purchase price upon 
prompt return of the product.

4 HP products may contain remanufactured parts equivalent to new 
in performance or may have been subject to incidental use. 

5 The warranty period begins on the date of the delivery or on the 
date of installation if installed by HP. If customer schedules or 
delays HP installation more than 30 days after delivery, warranty 
begins on the 31st day from delivery.

HP PRODUCT
HP 9100C Digital Sender 

DURATION OF WARRANTY
One year
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6 Warranty does not apply to defects resulting from improper or 
inadequate maintenance or calibration, software, interfacing, 
parts or supplies not supplied by HP, unauthorized modification or 
misuse, operation outside of the published environmental 
specifications for the product, or improper site preparation or 
maintenance.

Note Operation of the digital sender beyond the limit of its nominal duty cycle 
(scanning greater than the equivalent of 10,000 pages per month) shall 
be deemed digital sender abuse and all repairs thereafter are to be 
billed on a time-and-materials basis.

7 TO THE EXTEND ALLOWED BY LOCAL LAW, THE ABOVE 
WARRANTIES ARE EXCLUSIVE AND NO OTHER WARRANTY, 
WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIED 
AND HP SPECIFICALLY DISCLAIMS THE IMPLIED 
WARRANTIES OF MERCHANTABILITY, SATISFACTORY 
QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

8 HP will be liable for damage to tangible property per incident up 
to the greater of $300,000 or the actual amount paid for the 
product that is the subject of the claim, and for damages for bodily 
injury or death, to the extent that all such damages are 
determined by a court of competent jurisdiction to have been 
directly caused by a defective HP product.

9 TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES 
IN THIS WARRANTY STATEMENT ARE THE CUSTOMER’S 
SOLE AND EXCLUSIVE REMEDIES. EXCEPT AS INDICATED 
ABOVE, IN NO EVENT WILL HP BE LIABLE FOR LOSS OF 
DATA OR FOR DIRECT, SPECIAL, INCIDENTAL, 
CONSEQUENTIAL (INCLUDING LOST PROFIT OR DATA), OR 
OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, 
OR OTHERWISE.

10 FOR CONSUMER TRANSACTIONS IN AUSTRALIA AND NEW 
ZEALAND; THE WARRANTY TERMS CONTAINED IN THIS 
STATEMENT, EXCEPT TO THE EXTENT LAWFULLY 
PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND 
ARE IN ADDITION TO THE MANDATORY STATUTORY RIGHTS 
APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.
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HP customer support options worldwide

You can call HP for support using the table below. For all other 
support information, such as obtaining printer drivers or help using an 
online server or HP FIRST, see “HP support” on page 133. If you 
need a replacement part or information not listed in one of these two 
tables, see the administrator guide.

Customer Support and Product 
Repair Assistance for the U.S. and 
Canada:

(See the administrator guide for 
additional product repair 
information.)

Call (1) (208) 323-2551 Monday through Friday from 6 
am to 10 pm, Saturday 9 am to 4 pm (Mountain Time) 
free of charge during the warranty period. However, your 
standard long-distance phone charges still apply. Have 
your system nearby and your serial number ready when 
calling. 

Post-warranty telephone assistance is available to 
answer your product questions. Call (1) (900) 555-1500 
($2.50* per minute, U.S. only) or call 1-800-999-1148 
($25* per call, Visa or MasterCard, U.S. and Canada) 
Monday through Friday from 7 am to 6 pm and Saturday 
from 9 am to 3 pm (Mountain Time). Charges begin only 
when you connect with a support technician. *Prices 
subject to change.

European Customer Support Center Language and In-Country Options 
Available
Open Monday through Friday 8:30–18:00 CET.

HP provides a free telephone support service during the warranty period. By calling a telephone number 
listed below, you will be connected to a responsive team waiting to help you. If you require support after 
your warranty has expired, you can receive support for a fee through the same telephone number. The fee 
is charged on a per-incident basis. When calling HP, have the following information ready: product name 
and serial number, date of purchase, and description of the problem.

English

Dutch

French

Ireland: (353) (1) 662-5525
U.K.: (44) (171) 512-5202
International: (44) (171) 
512-5202
Belgium: (32) (2) 626-8806
Netherlands: (31) (20) 
606-8751
France: (33) (01) 43-62-
3434
Belgium: (32) (2) 626-8807
Switzerland: (41) (84) 
880-1111

German

Norwegian
Danish
Finnish
Swedish
Italian
Spanish
Portuguese

Germany: (49) (180) 
525-8143
Austria: (43) (1) 0660-6386
Norway: (47) 2211-6299
Denmark: (45) 3929-4099
Finland: (358) (9) 0203-47288
Sweden: (46) (8) 619-2170
Italy: (39) (2) 264-10350
Spain: (34) (90) 232-1123
Portugal: (351) (1) 441-7199
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In-country support numbers:   If you require support after your warranty has expired, additional 
product repair services, or if your country is not listed below, see the administrator guide.

Argentina 787-8080 Malaysia (60) (3) 295-2566

Australia (61) (3) 272-8000 Mexico (Mexico City) 01 800-22147

Brazil 022-829-6612 Mexico (outside 
Mexico City)

01 800-90529

Canada (1) (208) 323-2551 Middle East/Africa (41) (22) 780-7111

China (86) (10) 65053888-5959 New Zealand (64) (9) 356-6640

Chile 800-360999 Philippines (63) (2) 894-1451

Czech Republic (42) (2) 471-7321 Poland (48) (22) 37-5065

Greece (30) (1) 689-6411 Portugal (351) (1) 301-7330

Hong Kong (852) 800-96-7729 Russia (7) (95) 923-5001

Hungary (36) (1) 343-0310 Singapore (65) 272-5300

India (91) (11) 682-6035 Switzerland (41) (1) 753-7111

(91) (11) 682-6069 Taiwan (886) (02) 717-0055 

Indonesia (62) (21) 350-3408 Thailand (66) (2)661-4011

Korea (82) (2) 3270-0700 (66) (2)661- 4012

Korea
outside Seoul, call 

(82) (080) 999-0700 Turkey (90) (1) 224-5925

Japan (81) (3) 3335-8333
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HP support

Online services: for 24-hour 
access to information over your 
modem, we suggest these 
services:

World Wide Web URL - Printer drivers, updated HP printer 
software, plus product and support information may be obtained from 
the following URLs:  
for HP 9100C Digital Sender http://www.digitalsender.hp.com
in the U.S. http://www.hp.com
in Europe http://www2.hp.com
Printer drivers may be obtained from the following sites:
in Japan ftp://www.jpn.hp.com/drivers/
in Korea http://www.hp.co.kr
in Taiwan http://www.hp.com.tw
or the local driver website http://www.dds.com.tw

America Online - America Online/Bertelsmann is available in 
the U.S., France, Germany, and U.K. - Printer drivers, updated HP 
printer software, and support documentation to help answer your 
questions about HP products are available. Use Keyword HP to start 
your tour or call 1-800-827-6364 preferred customer # 1118 to 
subscribe. In Europe, call the appropriate number below:
Austria 0222 58 58 485
France ++353 1 704 90 00
Germany 0180 531 31 64
Switzerland 0848 80 10 11
United Kingdom 0800 279 1234

CompuServe - Printer drivers, updated HP printer software, and 
interactive sharing of technical information with other members is 
available on CompuServe’s “HP User’s forums” (GO HP), or call 
1-800-524-3388 and ask for representative #51 to subscribe. 
(CompuServe is also available in the U.K., France, Belgium, 
Switzerland, Germany, and Austria.)

Obtaining software 
utilities and electronic 
Information:

See “HP customer support options worldwide” on page 131.

HP direct ordering for 
accessories or supplies:

Call 1-800-538-8787 (U.S.) or 1-800-387-3154 (Canada).

HP Support Assistant 
compact disc:  

This support tool offers a comprehensive online information system 
designed to provide technical and product information on HP 
products. To subscribe to this quarterly service in the U.S. or Canada, 
call 1-800-457-1762. In Hong Kong, Indonesia, Malaysia, or 
Singapore, call Fulfill Plus at (65) 740-4477.

HP Service Information:  To locate HP-Authorized Dealers, call 1-800-243-9816 (U.S.) or 
1-800-387-3867 (Canada).

HP Service Agreements: Call 1-800-835-4747 (U.S.) or 1-800-268-1221 (Canada).
Extended Service 1-800-446-0522.
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HP FIRST: HP FIRST Fax will deliver detailed troubleshooting information on common software and 
troubleshooting tips for your HP product. Call from any touch-tone phone and request up to three 
documents per call. These documents will be sent to the fax of your choice.

Australia +61 (0) 3 9272 2627 Korea +82 (0) 02 769 0543

Austria 0660-8218 Malaysia +60 (0) 3 298 2478

Belgium (Dutch) 0800 1 1906 Netherlands 0800-0222420

Belgium (French) 0800 1 7043 New Zealand +64 (0) 09 356 6642

Canada 1-800-333-1917 Norway 800-11319

China +86 (0) 10 6505 5280 Portugal 05 05 313342

Denmark 800-10453 Philippines +65 275 7251

English (outside of U.K.) +31 20 681 5792 Singapore +65 275 7251

Finland 800-13134 Spain 900-993123

France 0800-905900 Sweden 020-79-5743

Germany 0130-810061 Switzerland (German) 0800-551527

Hong Kong 852-2506-2422 Switzerland (French) 0800-551526

Hungary (36) (1) 252-4647 Taiwan (886) (2) 719-5589

India +91 (0) 11 682 6031 Thailand +66 (0) 2 661 3511

Indonesia +62 (0) 21 352 2044 United Kingdom 0800-960271

Italy 1678-59020 United States 1-800-333-1917

Japan +81 (0) 3 3335 8622
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Index
Symbols
.pdf files

e-mailing 37
opening 39
reading attachments 39

A
A4 paper size, selecting 35
ABM (Address Book Manager). See Address Book 

Manager (ABM)
AC line voltage 121
accessories and supplies warranty 129
account, enabling 14
Acrobat Reader

attaching 39
downloading and installing 39
location 39

activity light 18
activity log

clearing 72
copying 71
maximum number of entries 124
messages 103
printing 72
saving 71
using for troubleshooting 88
viewing 70

adding
address book passwords 13
addresses to distribution lists 64
destinations to ABM 81
e-mail addresses 56
fax destinations to Public Fax address book 66
registered users 13

Address Book Manager (ABM)
adding destinations 81
changing user profiles 81
control panel error messages 97
controlling view 74
enabling account 14
logging in 20
main window 55
messages 114
online help 27
overview 15
starting 54
tutorial 20
uninstalling 11
using 49

address books
backing up 74
changing addresses 61
copying addresses 69
deleting addresses 62
duplicating 75
errors found 98
finding names 68
importing e-mail addresses 57
importing e-mail addresses from LDAP server 58
managing private distribution lists 63
moving addresses 69
not accessible at control panel 94
passwords 13
private 50
Public Distribution Lists 50
Public Email 50
Public Fax 50
Public Printers 50
renaming addresses 61
restoring 75

ADF (automatic document feeder)
clearing paper jams 90
guidelines 30
illustration 17
loading 32
specifications 122
using for double-sided documents 31

administrator guide 27
Adobe Acrobat Reader. See Acrobat Reader
agreements

service 133
software license 127

alphabetic keys 18
Alt key 18
America Online support service 133
applet, Control Panel 78
applications. See programs
attachments, reading .pdf 39
authorized dealers 133
automatic document feeder (ADF). See ADF 

(automatic document feeder)
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B
B/W Document setting 36
B/W Photo setting 36
Back key 18
backing up address books 74
black and white

document settings 36
photograph settings 36

blank pages 94

C
Cancel key 18
CC field 37
CD-ROM, problems reading 110
changing

ABM user profiles 81
addresses in distribution lists 65
default inbox location 82
Digital Sender Link options 81
e-mail addresses 61
fax destinations 67
format 35
network directories 60
paper size 35
quality setting 36
settings 35
user profiles 53
view of ABM main window 74

checking address books, errors found 98
choosing

default inbox location 82
e-mail destinations 37
target program 84

cleaning the glass 94
clearing paper jams

at end of a page 92
at start of a page 89
inside ADF 90

clearing the activity log 72
closing the Digital Sender Link 79
color

copying documents 42
photographs 36
settings 36

Color Document setting 36
Color-B/W Photo setting 36
comma separated value (CSV) files, importing e-mail 

addresses in 57
compact disc, problems reading 110
compression features 121
CompuServe support service 133
computer

cannot connect to 97
requirements 8
sending to 44

configuring

ABM account 14
address book passwords 13
default inbox settings 82
e-mail confirmations 14
registered users 13
target program 84

confirmations
DNS support 14
enabling 14
of e-mail transmissions not arriving 96
of fax transmissions not arriving 96

conformity, declaration of 126
consumption, power 121
control panel

address books not accessible 94
features 18
illustration 18
light 88
maximum number of selections 124
messages 97
not working 93
setting receive capabilities 83
specifications 122

Control Panel applet
starting 78

controlling ABM main window view 74
convenience copying, maximum number of printers 

124
COPY function key 42
copying

activity log 71
color documents 42
documents 42
e-mail addresses 69

copyright, viewing 81
CSV (comma separated value) files, importing e-mail 

addresses in 57
custom installation 9
customer support options worldwide 131
cycle, duty 121

D
daemon. See Digital Sender Service
database of address books, errors 98
dealers, authorized 133
declaration of conformity 126
defaults

inbox settings 82
installation 9

defects in product 129
defining network directories 58
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deleting
addresses in distribution lists 64
distribution lists 65
e-mail addresses 62
fax destinations in Public Fax address book 67
network directories 60

Delivery Service Notification (DSN) 14
description

Address Book Manager (ABM) 15
digital sender 7
Digital Sender Link 16

destinations
adding to Public Fax address book 66
choosing e-mail 37
deleting fax 67
fax numbers 40
maximum number for function keys 124
sending e-mail to 38
types 29

Digital Sender Link
changing settings 81
closing 79
disabling 81
enabling 81
icon not showing in taskbar 111
messages 118
online help 27
overview 16
running with Digital Sender Service 11
sending to 25
setting receive capabilities from icon 83
setting up 16
starting 78
taskbar icon options 81
uninstalling 11
using 78
will not start 111

Digital Sender Service, running with Digital Sender 
Link 11

directories
changing network 60
defining network 58
deleting network 60

disabling the Digital Sender Link 81
disk space requirements 8
distribution lists

adding addresses 64
changing addresses 65
copying 69
creating private 63
deleting 65
deleting addresses 64
e-mail addresses 37
maximum number of destinations 124

DNS (Domain Name System) configuration problem 
100

document guides
administrator 27
paper 17
quick reference 26

document output support 17
document output tray 17
documents

black and white settings 36
color settings 36
copying 42
copying color 42
e-mailing 37
e-mailing .pdf files 37
faxing 40
guidelines for ADF 30
importing from PaperPort 8
loading in ADF 32
loading on glass 33
not printing at printer 95
pages cut off bottom 96
preparing to send 30
reading .pdf attachments 39
sending double-sided 31
sending next 48
sending to computer 44
sent as e-mail messages not arriving 95
sent as faxes not arriving 95
sent to computer not arriving 95
types supported 30

double-sided
key 19
sending with ADF 31
sending with glass 31

drivers, printer 133
DSN (Delivery Service Notification) 14
duplex. See double-sided
duplicating address books 75
duty cycle 121

E
e-mail

configuration problem 100
server unavailable 98

e-mail addresses 37
adding 56
changing 61
copying 69
deleting 62
importing 57
importing from LDAP server 58
importing in comma separated value (CSV) files 

57
importing in LDAP Data Interchange Format (LDIF) 

files 57
importing in Microsoft Exchange format 57
maximum number 124
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moving 69
renaming 61

e-mail transmissions
confirmations not arriving 96
enabling confirmations 14
not arriving at destinations 95
not receiving confirmations 111

e-mailing
.pdf files 37
choosing destinations 37
documents 37
to destinations 38

Enable Receive setting, enabling 95
enabling

ABM account 14
Digital Sender Link 81
notifications 14

Enter key 18
environmental specifications 123
equipment

specifications 121
troubleshooting 93

error activity log messages 103
errors. See troubleshooting
Ethernet interface 121
Exchange (MS) format, importing e-mail addresses 

in 57

F
fatal activity log messages 103
fax daemon. See Digital Sender Service
fax destinations

adding to Public Fax address book 66
changing in Public Fax address book 67
deleting from Public Fax address book 67

FAX function key 40
fax support service 134
fax transaction reports not arriving 96
fax transmissions

maximum number 124
no LAN fax program 40
not arriving 95
not receiving confirmations 111
pending, maximum number 124
sending 40

features
compression 121
control panel 18
product 7

feeding problems 94
finding names in address books 68
Fine Text setting 36
flashing light on control panel 88
format, changing 35
FROM field 37
front panel. See control panel

function keys
COPY 42
FAX 40
illustration 18
maximum number of customized 124

G
G4 compression 121
German noise declaration 125
glass

cleaning 94
loading 33
sending double-sided documents 31

Go key 18
green light on control panel 88
guest users 13, 52
guides

administrator 27
paper 17
quick reference 26

H
hardware

compression 121
repair assistance 131
specifications 121
troubleshooting 93
warranty 129

heating problem 93
Help

key 18
help

online for ABM 27
online for digital sender 26
online for Digital Sender Link 27

hiding
taskbar icon 80

high-resolution color setting 36
Hi-Res Color-B/W setting 36
HP authorized dealers 133
HP Digital Sender Link. See Digital Sender Link
HP FIRST fax support service 134
HP JetSend. See JetSend
HP Network ScanJet 5 scanner

coexistence with 8
HP ScanJet Utility, using with digital sender 8
HP Smart Compression Imaging Technology 121
HP Support Assistant compact disc 133
humidity

operating 123
storage 123
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I
icons

Digital Sender Link taskbar options 81
using taskbar 80

idle state 88
illustrations

ADF unit 17
Back key 18
Cancel key 18
document guides for paper 17
document output support 17
document output tray 17
Enter key 18
Go key 18
Help key 18
light 18
numeric keys 18
power switch 17
scroll arrow keys 18
single-sided/double-sided key 18

image processing options 121
image quality problems 94
importing

e-mail addresses 57
e-mail addresses from LDAP server 58

inbox
changing default location 82
choosing default location 82
configuring default settings 82
setting and enabling receive 95

Inbox tab 16
installation

default 9
messages 113
methods 9
requirements 8
steps 10

interface type 121
internal errors 98

J
jams

clearing at end of a page 92
clearing at start of a page 89
clearing inside ADF 90
troubleshooting 94

JetDirect print server not responding 99
JetSend

adding devices 47
device unreachable 97
invalid PIN 99
not responding 99
sending to devices 47

jobs pending lost 95
JPEG compression 121

K
keyboard. See keypad
keypad

illustration 18
specifications 122

keys
alphabetic 18
Alt 18
Back 18
Cancel 18
Enter 18
function 18
Go 18
Help 18
illustration 18
numeric 18
scroll arrow 18
single-sided/double-sided 18
Tab 18

L
LAN fax daemon. See Digital Sender Service
LAN fax program not installed 40
LAN interface 121
language support options 131
launching, setting automatic 85
LDAP (Lightweight Directory Access Protocol)

configuration problem 100
protocol error 99
server 58
server unavailable 101
using to import e-mail addresses 58

LDAP Data Interchange Format (LDIF) files, 
importing e-mail addresses in 57

LDIF (LDAP Data Interchange Format) files, 
importing e-mail addresses in 57

LED on control panel 88
legal paper size, selecting 35
letter paper size, selecting 35
license, software 127
light

control panel 88
source for scanning 121

limited warranty statement 129
line voltage 121
Link. See Digital Sender Link
lists, distribution. See distribution lists
loading

ADF 32
documents on glass 33

locked, sending documents when 93
log, activity. See activity log
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logging in 23
as registered user 34
duplicate 115
registered user 23
to ABM 20
to digital sender 23

lost pending jobs 95
lower rollers, residue problem 94

M
media. See documents
memory

capabilities 124
requirements 8

messages
activity log 103
Address Book Manager 114
control panel 97
Digital Sender Link 118
installation 113

Microsoft Exchange format, importing e-mail 
addresses in 57

moving, e-mail addresses 69

N
names, finding in address books 68
Network ScanJet 5 scanner

coexistence with 8
networks

changing directories 60
defining directories 58
deleting directories 60
errors 99

noise
German declaration 125
levels 121
problem 93

normal activity log messages 103
notifications

DNS support 14
enabling 14
of e-mail transmissions not arriving 96
of faxes not arriving 96

numeric keys 18

O
OCR (optical character recognition)

settings 36
online help

ABM 27
digital sender 26
Digital Sender Link 27

online support services 133
opening .pdf files 39
operating

humidity 123
temperature 123

optical character recognition (OCR). See OCR 
(optical character recognition)

optical resolution 121
options

Digital Sender Link taskbar icon 81
sending 36

orange light on control panel 88
output support, document 17
output tray, document 17
overheating problem 93
overview

Address Book Manager (ABM) 15
digital sender 7

P
pages

bottom cut off 96
missing in second pass 99
too many in second pass 102

panel, control. See control panel
paper jams

clearing at end of a page 92
clearing at start of a page 89
clearing inside ADF 90
troubleshooting 94

paper size
choices 35
selecting 35

PaperPort software, using with digital sender 8
passwords

address book 13
entering 23
not accepted 93
registered user 34

PC address
configuring 14
invalid 101

PC. See computer
PDF files. See .pdf files
pending fax transmissions

maximum number 124
too many 102

pending jobs lost 95
Pentium processor 8
personal identification number (PIN), invalid 99
photographs

black and white settings 36
sending color 36

PIN (personal identification number), invalid 99
power

consumption 121
switch 17

print quality problem 94
printers
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color 42
documents not arriving 95
drivers 133
maximum number for convenience copying 124

printing the activity log 72
private address books

description 50
e-mail addresses 37
maximum number of addresses 124

private distribution lists
adding addresses 64
changing addresses 65
deleting 65
deleting addresses 64

Private Distribution Lists address book
creating lists 63
managing 63
maximum destinations in a list 124
maximum number of lists 124

problems. See troubleshooting
processor, Pentium 8
product features 7
profiles, user. See user profiles
programs

configuring target 84
sending to 46
setting automatic for target 85

properties, viewing 73
Public Distribution Lists address book

description 50
maximum number of lists 124
using 63

Public Email address book
description 50
maximum number of addresses 124

Public Fax address book
adding destinations 66
changing destinations 67
deleting destinations 67
description 50
maximum number of addresses 124
using 40

Public Printers address book
description 50
maximum number of printers 124

Q
quality settings

changing 36
types 36

quick reference guide 26

R
RAM (random access memory) requirements 8
random access memory (RAM) requirements 8
Reader. See Acrobat Reader
reading .pdf files 39
receive inbox

enabling 95
setting 95

receiving capabilities, setting 83
red light on control panel 88
refreshing view of ABM main window 74
registered users

adding 13
adding e-mail addresses 56
adding profile 52
entering password 23
importing e-mail addresses 57
logging in 34
passwords 34
PC address 14
user profile 51

registering user profiles 10
renaming e-mail addresses 61
repair and replacement 129
repair assistance 131
replacement and repair 129
reports of fax transmissions not arriving 96
requirements, system 8
resolution

document settings 36
optical 121

restoring address books 75
rollers, residue on lower 94

S
saving

activity log 71
address books 74

ScanJet Utility, using with digital sender 8
scanners, coexistence with 8
scanning speed 121
scroll arrow keys 18
searches

slow 101
too many matches 102

sending
black and white documents 36
black and white photographs 36
changing settings 36
choosing target program 84
color documents 36
color photographs 36
guidelines 31
high-resolution color documents 36
next document 48
OCR documents 36
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options 36
preparing documents 30
setting automatic program launch 85
text documents 36
to a printer 42
to another program 46
to computer 44
to Digital Sender Link 25
to e-mail destinations 38
to fax destinations 40
to JetSend-enabled devices 47
when to use glass 31

servers
e-mail unavailable 98
LDAP 58
LDAP unavailable 101
SMTP 108

service agreements 133
service and support

language options 131
options worldwide 131
warranty information 130

settings
automatic program launch 85
black and white documents 36
black and white photographs 36
changing 35
color documents 36
color photographs 36
default inbox 82
Digital Sender Link 81
high-resolution color 36
OCR documents 36
receive capabilities 83
target program 84
text scanning 36

showing
taskbar icon 80

simplex. See single-sided/double-sided key
Single-sided/double-sided key 18
size of paper, changing 35
slow sending problem 94
Smart Compression Imaging Technology 121
SMTP server 108
software

components 9
compression 121
custom installation 9
did not install 110
installing 9
license agreement 127
running slowly 111
typical installation 9
uninstalling 11
utilities 133
warranty 129

space, disk requirements 8
specifications

environmental 123
equipment 121
keypad 122

speed
problems 94, 111
scanning 121

starting
ABM 54
Control Panel applet 78
Digital Sender Link 78
setting automatic 85

statement of warranty 129
stopping the Digital Sender Link 79
storage

humidity 123
temperature 123

SUBJECT field 37
supplies and accessories warranty 129
support agreements 133
support and service

language options 131
options worldwide 131
warranty information 130

Support Assistant compact disc 133
switch, power 17
system requirements 8

T
Tab key 18
target programs

cannot find 120
choosing 84
configuring 84
setting automatic launch 85

taskbar icon
hiding 80
showing 80
using 80

telephone numbers, maximum number of characters 
124

temperature
operating 123
storage 123

text document settings 36
timeout 117
TO field 37
Token Ring interface 121
transaction reports not arriving 96
troubleshooting

control panel 93
DNS configuration 100
e-mail configuration 100
e-mail transmissions 95
general 93
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hardware 93
image quality 94
installation 11
internal errors 98
LDAP configuration 100
misfeeds 94
network errors 99
paper jams 94
repair assistance 131
slow sending 94
sources for information about problems 88
tips from HP FIRST fax support 134
WINS configuration 101

tutorial for ABM 20
typical installation 9

U
uninstalling software 11
user profiles

adding 13
adding destinations through ABM 81
changing 53
changing through ABM 81
description 12
registered users 51
registering 10

users
description 12
maximum number 124
PC address 14
profiles 12
types 12

using
ABM 49
Digital Sender Link 78
Digital Sender Link icon 80

utilities, software 133

V
viewing

activity log 70
controlling for ABM main window 74
copyright 81
properties 73

voltage, AC line 121

W
warning activity log messages 103
warranty statement 129
websites

Adobe Systems Incorporated 39
weight

digital sender 121
paper 30

white pages when sending 94

Windows
registry problem 114
system requirements 8

WINS (Windows Internet Naming Service) 
configuration problem 101

World Wide Web support service 133
worldwide, support options 131
WWW support service 133
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